
1 | P a g e

Syllabus wise NOTES for BPSC TRE 4.0 Computer Teacher Exam
Preparation



2 | P a g e

Table of Content

Topics Pages1. Fundamentals of Computers: History, types, generations, hardware,software, I/O devices.
NOTES 3 -62. Operating Systems: Windows, Linux, basic commands, file management.
NOTES 7 - 103. Programming: Basics of C, C++, Python, Java (syntax, logic, flowcharts,algorithms).
NOTES 11 - 164. Data Structures: Arrays, stacks, queues, linked lists, trees, graphs,searching & sorting.
NOTES 17 - 235. Database Management: DBMS concepts, SQL basics, ER diagrams,normalization.
NOTES 24 - 286. Networking: OSI model, TCP/IP, LAN/WAN, Internet basics, networkdevices, security.
NOTES 29 - 337. Web Technologies: HTML, CSS, basics of JavaScript, Internet and WWW.
NOTES 34 - 398. MS Office Suite: Word, Excel, PowerPoint, practical applications ineducation.
NOTES 40 - 439. Computer Security: Viruses, malware, firewalls, safe practices.
NOTES 44 - 4710. ICT in Education: Role of computers in teaching, e-learning tools, digitalclassroom management.
NOTES 48 – 5111. Recent Trends: Cloud computing, artificial intelligence basics, IoT, digitalIndia initiatives
NOTES 52 -56



3 | P a g e

Topic 1: Fundamentals of Computers: History, Types, Generations,
Hardware, Software, I/O Devices
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Introduction to Computer Fundamentals
A computer is an electronic device that processes raw data to produce meaningful
information. Its evolution spans thousands of years, from primitive counting tools to
modern supercomputers. This guide covers the history, types, generations,
hardware, software, and input/output devices of computers.

2. History of Computers
Ancient to Modern Era
Abacus: The first known calculating device, used in ancient Babylon and China.Mechanical Calculators: Blaise Pascal (Pascaline), Gottfried Leibniz (Stepped Reckoner).Analytical Engine: Designed by Charles Babbage; considered the first concept of a programmablecomputer.Punched Card Machines: Used by Herman Hollerith for the 1890 US Census.Electronic Computers:ENIAC (1945): First general-purpose electronic digital computer.UNIVAC I (1951): First commercial computer in the US.
Early Computing Devices (3000 BC – 19th Century)
The history of computers begins with the abacus, invented in Babylon around 3000 BC. This woodenframe with beads enabled basic arithmetic operations. In 1642, Blaise Pascal created the Pascaline, amechanical calculator for addition. Later, Gottfried Leibniz improved it to perform multiplication. Thesedevices laid the groundwork for mechanical computation.
Electromechanical Era (19th–20th Century)
1822: Charles Babbage designed the Difference Engine, the first automated mechanical calculator.
1890: Herman Hollerith developed punched-card machines for the U.S. Census, leading to the foundingof IBM.
Electronic Computers (20th Century)
1941: Atanasoff-Berry Computer (ABC), the first electronic digital computer, used vacuum tubes forsolving equations.1945: ENIAC, the first general-purpose electronic computer, weighed 30 tons and occupied 1,800 squarefeet.1951: UNIVAC I became the first commercial computer, used for business applications.
Modern Computing (21st Century)
2001: Apple released macOS, revolutionizing personal computing.2010s: Tablets and smartphones emerged, driven by advancements in microprocessors.
3. Types of Computers
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By Data HandlingAnalog Computers: Work with continuous data (e.g., thermometer).Examples: Thermometers, speedometers.
Digital Computers: Work with discrete data (binary 0s and 1s); most common today.Examples: Laptops, smartphones.
Hybrid Computers: Combine analog and digital features (e.g., hospital monitoring systems).Based on Size and Capacity
By Size and PowerSupercomputers: Fastest, used for weather forecasting, scientific research (e.g., climate modeling).Example: Fugaku (Japan).Mainframe Computers: Large organizations, bulk data processing. Handle large-scale data processing forcorporations (e.g., banking).Minicomputers: Mid-sized, used in universities and businesses.Microcomputers: Personal computers, laptops, tablets, smartphones.
Digital Computers:Use binary digits (0s/1s) for calculations.Examples: Laptops, smartphones.
4. Generations of Computers
Generation Technology Used Example Features
First (1940-56) Vacuum Tubes ENIAC Large, slow, high

power use
Second (1956-63) Transistors IBM 1401 Smaller, faster, less

heat
Third (1964-71) Integrated Circuits IBM 360 Even smaller,

multitasking
Fourth (1971-
Now)

Microprocessors PCs, Laptops Affordable, user-
friendly

Fifth (Now-
Future)

AI, Quantum,
Nanotech

Modern AI PCs Intelligent,
voice/image
recognition

5. HardwareHardware refers to the physical parts of a computer system.
A. Input DevicesKeyboard: For typing text and commands.Mouse: Pointing device for navigation.Scanner: Converts documents/images into digital form.Microphone: Records audio input.Webcam: Captures video input.
B. Output DevicesMonitor: Displays text, images, and videos.Printer: Produces physical copies of documents.
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Speakers: Output sound.
C. Processing DeviceCPU (Central Processing Unit): The "brain" of the computer, processes instructions.ALU (Arithmetic Logic Unit): Performs calculations.CU (Control Unit): Directs operations.
D. Storage DevicesPrimary Storage: RAM (Random Access Memory) – temporary, volatile.Secondary Storage: Hard Disk, SSD, Pen Drive – permanent, non-volatile.
6. SoftwareSoftware is a set of instructions that tells the hardware what to do.A. System SoftwareOperating System (OS): Manages hardware and software (Windows, Linux, macOS).Utility Software: Tools for maintenance (antivirus, disk cleaner).
B. Application SoftwareWord Processors: MS Word.Spreadsheets: MS Excel.Browsers: Chrome, Firefox.
7. Input/Output (I/O) DevicesInput Devices: Keyboard, mouse, scanner, microphone, joystick.Output Devices: Monitor, printer, speakers, projector.
8. Data RepresentationDigital Data: Uses binary (0,1).Analog Data: Continuous signals (sound, temperature).Number Systems: Decimal, Binary, Hexadecimal.

Topic 2: Operating Systems: Windows, Linux, Basic Commands, and
File Management



7 | P a g e

1. What is an Operating System (OS)?
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An Operating System (OS) is system software that acts as an interface between the user and computerhardware. It manages hardware resources, runs applications, and provides services to users andprograms.
Main Functions:Manages files and foldersControls input/output devicesAllocates memory and processing powerProvides a user interface (GUI or CLI)Handles security and user permissions
2. Windows Operating SystemWindows is a popular OS developed by Microsoft. It is widely used in homes, schools, and offices.
Key Features:
Graphical User Interface (GUI): Uses icons, windows, and menus for easy navigation.Taskbar & Start Menu: Quick access to programs and settings.File Explorer: Tool to manage files and folders.Control Panel/Settings: For system configurations.Multitasking: Run multiple applications at once.Common Windows Versions: Windows 7, Windows 8, Windows 10, Windows 11.
Basic Tasks in Windows:
Creating, renaming, copying, moving, and deleting files/folders.Installing and uninstalling software.Using shortcuts (e.g., Ctrl+C to copy, Ctrl+V to paste).

2. Linux Operating System
Linux is an open-source OS, meaning its source code is freely available. It is used in servers, desktops,and embedded systems.
Key Features:
Open-source: Free to use and modify.Security: Known for strong security and stability.Customizable: Many distributions (Ubuntu, Fedora, Debian).Command Line Interface (CLI): Powerful text-based control.Common Linux Distributions: Ubuntu, Fedora, Debian, Red Hat, Linux Mint.Linux Desktop Environment: Similar to Windows but may look different based on the distribution (e.g.,GNOME, KDE).

3. Basic Commands (Windows & Linux)
A. Windows (Command Prompt)dir – List files and folders in a directory.
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cd – Change directory.copy – Copy files.del – Delete files.mkdir – Create a new folder.rmdir – Remove a folder.
B. Linux (Terminal)ls – List files and folders.cd – Change directory.cp – Copy files or folders.mv – Move or rename files/folders.rm – Remove files.mkdir – Make a new directory.rmdir – Remove an empty directory.pwd – Print working directory (shows current location).cat – View file contents.touch – Create a new empty file.Note: Linux commands are case-sensitive.

4. File Management
Managing files and folders is a key function of any OS.Common File Operations:Create: Make new files or folders.Rename: Change the name of a file or folder.Copy: Make a duplicate of a file or folder.Move: Change the location of a file or folder.Delete: Remove files or folders permanently (or send to Recycle Bin/Trash).Search: Find files or folders by name or type.
File Extensions:Windows uses extensions to identify file types (e.g., .docx for Word, .jpg for images, .exe for programs).
Organizing Files:Use folders to group related files.Use meaningful names for easy searching.
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6. Differences Between Windows and Linux
Feature Windows Linux
Cost Paid (mostly) Free and open-source
User Interface GUI-focused Both GUI and CLI
Security Good, but common target

for viruses
Strong security, less prone
to viruses

Customization Limited Highly customizable
Common Users Home, office, schools Servers, professionals,

programmers
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Topic 3: Programming: Basics of C, C++, Python, Java (Syntax, Logic,
Flowcharts, Algorithms)
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1. Introduction to Programming LanguagesProgramming languages are tools that allow humans to communicate instructions to computers. Four ofthe most widely used languages for learning and real-world applications are C, C++, Python, and Java.Each has its own syntax, features, and use cases.
2. Basics of C, C++, Python, and JavaA. C LanguageType: Compiled, procedural language.Use: System programming, embedded systems, operating systems.Syntax Example:

Key Points:Uses functions and procedures.Variables must be declared with data types.Case-sensitive.Uses ; to end statements.
B. C++ LanguageType: Compiled, object-oriented and procedural.Use: System/software development, games, device drivers, GUI applications.Syntax Example:

Key Points:Supports classes, objects, inheritance, polymorphism, encapsulation, abstraction.Function overloading, operator overloading.Uses cin and cout for input/output.Case-sensitive.File extension: .cpp



13 | P a g e

C. Python LanguageType: Interpreted, high-level, dynamically typed.Use: Web development, data science, automation, scripting, AI/ML.Syntax Example:

Key Points:Simple, readable syntax.No need to declare variable types.Indentation is used to define code blocks.Huge library support.File extension: .py
D. Java LanguageType: Compiled and interpreted (via JVM), object-oriented.Use: Web applications, enterprise software, Android apps.Syntax Example:

Key Points:Everything is inside a class.Statically typed (variables must be declared).Platform-independent via Java Virtual Machine (JVM).Supports inheritance, encapsulation, abstraction, polymorphism.File extension: .java
3. Syntax and LogicSyntax: The set of rules that defines the combinations of symbols considered to be correctly structuredprograms.Logic: The sequence of instructions that solves a problem.Example: Add two numbers
C:
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C++:

Python:

Java:

4. FlowchartsA flowchart is a diagram that represents the sequence of steps in a program or process. It uses symbolslike:Oval: Start/EndParallelogram: Input/OutputRectangle: Process/InstructionDiamond: Decision (Yes/No)Example: Flowchart for Adding Two Numbers



15 | P a g e

5. AlgorithmsAn algorithm is a step-by-step procedure to solve a problem.Example: Algorithm for Adding Two NumbersStartInput two numbers (a, b)Add the numbers: sum = a + bOutput the sumEnd

Key Differences Between C, C++, Python, Java
Feature C C++ Python Java
Type Procedural Object-

oriented &
Procedural

Interpreted,
Object-based

Object-
oriented

Compilation Compiled Compiled Interpreted Compiled +
Interpreted

Syntax Strict Strict, with
OOP

Simple,
readable

Strict, class-
based

Memory
Management

Manual Manual Automatic Automatic
(Garbage
Collection)

Use Cases System,
Embedded

System, Apps,
Games

Web, Data
Science,
Scripting

Apps, Web,
Mobile

Platform Platform-
dependent

Platform-
dependent

Platform-
independent

Platform-
independent
(JVM)

Library
Support

Basic Moderate Extensive Extensive
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Summary Table: Hello World in All Languages

8. ConclusionC is foundational, fast, and close to hardware.C++ adds object-oriented features and is used for complex systems.Python is easy, versatile, and great for beginners and rapid development.Java is robust, platform-independent, and widely used in enterprise and mobile apps.
Understanding syntax, logic, flowcharts, and algorithms in these languages is essential for building astrong programming foundation for the BPSC TRE 4.0 Computer Teacher exam.
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Topic 4: Data Structures: Arrays, stacks, queues, linked lists, trees,graphs, searching & sorting.
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1. What Are Data Structures?A data structure is a special way of organizing and storing data in a computer so that it can be usedefficiently. Data structures help programmers manage, access, and process data for various tasks andalgorithms.
Types:
Linear Data Structures: Elements are arranged in a sequence (e.g., Arrays, Linked Lists, Stacks, Queues).Non-Linear Data Structures: Elements are arranged in a hierarchical or networked fashion (e.g., Trees,Graphs).
2. Arrays
Definition: An array is a collection of elements, all of the same type, stored in contiguous memorylocations. Each element can be accessed using an index.
Properties:Fixed size.Fast access by index (random access).Insertion/deletion is costly except at the end.
Example:int arr[5] = {1, 2, 3, 4, 5};
Applications: Storing lists of items like marks, names, etc..
3. Linked ListsDefinition: A linked list is a collection of nodes, where each node contains data and a reference (link) tothe next node in the sequence.
Types:
Singly Linked List: Each node points to the next node.Doubly Linked List: Each node points to both the next and previous node.Circular Linked List: The last node points back to the first node.
Properties:Dynamic size (can grow/shrink).Efficient insertions/deletions.Slower access (need to traverse nodes).
Applications: Implementing stacks, queues, dynamic memory management, browser history(forward/backward buttons).
4. Stacks



19 | P a g e

Definition: A stack is a linear data structure that follows the Last-In, First-Out (LIFO) principle. Insertionand deletion happen only at the top.
Operations:Push: Add an item to the top.Pop: Remove the top item.Peek/Top: View the top item without removing.
Applications: Function call management, undo operations, expression evaluation, backtracking.
5. QueuesDefinition: A queue is a linear data structure that follows the First-In, First-Out (FIFO) principle. Insertionhappens at the rear, deletion at the front.
Operations:Enqueue: Add an item at the rear.Dequeue: Remove an item from the front.
Types:Simple QueueCircular QueuePriority Queue
Applications: Printer task scheduling, CPU task scheduling, call center systems.
6. TreesDefinition: A tree is a non-linear, hierarchical data structure consisting of nodes, with a single root nodeand sub-nodes (children).
Properties:
Root: The top node.Leaf: Node with no children.
Parent/Child: Relationship between nodes.
Types:
Binary Tree: Each node has at most two children.Binary Search Tree (BST): Left child < parent < right child.
Applications: File systems, databases, searching and sorting, hierarchical data representation.
7. GraphsDefinition: A graph is a collection of nodes (vertices) connected by edges. It can represent networks andrelationships.
Types:
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Directed Graph: Edges have direction.Undirected Graph: Edges have no direction.Weighted Graph: Edges have weights (costs).
Representation:Adjacency Matrix: 2D array.Adjacency List: List of lists or linked lists.
Applications: Social networks, maps, network routing, web page links.
8. Searching Algorithms
Linear Search: Check each element one by one.Time Complexity: O(n)Binary Search: Repeatedly divide sorted array and search.Time Complexity: O(log n)
Note: Works only on sorted data.
9. Sorting Algorithms
Bubble Sort: Repeatedly swap adjacent elements if they are in the wrong order.Selection Sort: Select the smallest/largest element and place it at the correct position.Insertion Sort: Build the sorted array one item at a time.Quick Sort, Merge Sort: Advanced, faster algorithms for large data sets.
1. What Are Data Structures?
A data structure is a special way of organizing and storing data in a computer so that it can be usedefficiently. Data structures help programmers manage, access, and process data for various tasks andalgorithms.
Types:
Linear Data Structures: Elements are arranged in a sequence (e.g., Arrays, Linked Lists, Stacks, Queues).
Non-Linear Data Structures: Elements are arranged in a hierarchical or networked fashion (e.g., Trees,Graphs).
2. ArraysDefinition: An array is a collection of elements, all of the same type, stored in contiguous memorylocations. Each element can be accessed using an index.
Properties:
Fixed size.Fast access by index (random access).
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Insertion/deletion is costly except at the end.
Example:int arr[5] = {1, 2, 3, 4, 5};
Applications: Storing lists of items like marks, names, etc..
3. Linked ListsDefinition: A linked list is a collection of nodes, where each node contains data and a reference (link) tothe next node in the sequence.
Types:
Singly Linked List: Each node points to the next node.Doubly Linked List: Each node points to both the next and previous node.Circular Linked List: The last node points back to the first node.
Properties:
Dynamic size (can grow/shrink).Efficient insertions/deletions.Slower access (need to traverse nodes).
Applications: Implementing stacks, queues, dynamic memory management, browser history(forward/backward buttons).
4. StacksDefinition: A stack is a linear data structure that follows the Last-In, First-Out (LIFO) principle. Insertionand deletion happen only at the top.
Operations:Push: Add an item to the top.Pop: Remove the top item.Peek/Top: View the top item without removing.
Applications: Function call management, undo operations, expression evaluation, backtracking.
5. QueuesDefinition: A queue is a linear data structure that follows the First-In, First-Out (FIFO) principle. Insertionhappens at the rear, deletion at the front.
Operations:
Enqueue: Add an item at the rear.Dequeue: Remove an item from the front.
Types:Simple Queue
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Circular QueuePriority Queue
Applications: Printer task scheduling, CPU task scheduling, call center systems.
6. TreesDefinition: A tree is a non-linear, hierarchical data structure consisting of nodes, with a single root nodeand sub-nodes (children).
Properties:Root: The top node.Leaf: Node with no children.Parent/Child: Relationship between nodes.
Types:
Binary Tree: Each node has at most two children.Binary Search Tree (BST): Left child < parent < right child.
Applications: File systems, databases, searching and sorting, hierarchical data representation.
7. GraphsDefinition: A graph is a collection of nodes (vertices) connected by edges. It can represent networks andrelationships.
Types:Directed Graph: Edges have direction.Undirected Graph: Edges have no direction.Weighted Graph: Edges have weights (costs).
Representation:Adjacency Matrix: 2D array.Adjacency List: List of lists or linked lists.
Applications: Social networks, maps, network routing, web page links.
8. Searching AlgorithmsLinear Search: Check each element one by one.Time Complexity: O(n)Binary Search: Repeatedly divide sorted array and search.Time Complexity: O(log n)
Note: Works only on sorted data.
9. Sorting AlgorithmsBubble Sort: Repeatedly swap adjacent elements if they are in the wrong order.Selection Sort: Select the smallest/largest element and place it at the correct position.Insertion Sort: Build the sorted array one item at a time.
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Quick Sort, Merge Sort: Advanced, faster algorithms for large data sets.
Summary Table
Data Structure Linear/Non-

Linear
Key Feature Example Use

Array Linear Fast access by
index

Storing marks,
lists

Linked List Linear Dynamic size,
easy insert

Browser history,
memory mgmt

Stack Linear LIFO, one-end
operations

Undo, function
calls

Queue Linear FIFO, two-end
operations

Print queue, task
scheduling

Tree Non-Linear Hierarchical
relationships

File systems,
databases

Graph Non-Linear Networked
relationships

Social networks,
maps

Why Are Data Structures Important?
They help organize data efficiently.Enable fast searching, insertion, and deletion.Essential for writing optimized programs and solving real-world problems
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Topic 5: Database Management: DBMS concepts, SQL
basics, ER diagrams, normalization.
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1. DBMS Concepts
What is a DBMS?
A Database Management System (DBMS) is software that helps you create, store, organize,
retrieve, and manage data in databases. It acts as an interface between users/applications and
the actual data, ensuring data is consistently and securely handled.
Key Features and Functions:
Data Storage & Retrieval: Stores data in tables (rows and columns) and allows quick access and
manipulation.
Data Integrity: Maintains accuracy and consistency of data.
Concurrency Control: Supports multiple users accessing data simultaneously without conflict.
Security: Restricts unauthorized access, provides user roles and permissions.
Backup & Recovery: Allows data backup and restores data in case of failure.
Data Independence: Applications are insulated from changes in data structure.
ACID Properties: Ensures transactions are Atomic, Consistent, Isolated, and Durable for
reliability.
DBMS Components:
Storage Engine: Manages data storage on disk.
Query Processor: Interprets and executes database queries.
Database Schema: Defines the logical structure of the database.
Metadata Catalog: Stores information about database structure (tables, columns, relationships).
User Interface: Provides ways for users to interact with the database (command line, GUI, API).
2. SQL Basics
SQL (Structured Query Language) is the standard language for interacting with relational
databases. It is used to create, modify, manage, and query data.
Main Categories of SQL Commands:
Data Definition Language (DDL): Defines database structure.
CREATE TABLE, ALTER TABLE, DROP TABLE
Data Manipulation Language (DML): Handles data within tables.
SELECT, INSERT, UPDATE, DELETE
Data Control Language (DCL): Controls access to data.
GRANT, REVOKE
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Transaction Control Language (TCL): Manages transactions.
COMMIT, ROLLBACK, SAVEPOINT

Common SQL Statements:

Create a Table:

Insert Data:

Select Data:

Update Data:

Delete Data:
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3. ER Diagrams (Entity-Relationship Diagrams)
ER Diagrams are visual representations of the data and their relationships in a database.
Basic Components:

 Entity: Object or thing in the real world (e.g., Student, Course).
 Attribute: Property of an entity (e.g., Name, RollNo).
 Relationship: Association between entities (e.g., "enrolls" between Student and Course).

Symbols Used:
 Rectangle: Entity
 Ellipse: Attribute
 Diamond: Relationship
 Line: Connects attributes to entities and entities to relationships

Example:
 Entities: Student, Course
 Relationship: Student "enrolls" in Course

ER diagrams help in database design by clearly showing how data is
structured and related.

4. Normalization
Normalization is a process to organize data in a database to reduce redundancy and improve
data integrity.

Goals of Normalization:
 Eliminate duplicate data (redundancy)
 Ensure data dependencies make sense

Normal Forms:
1st Normal Form (1NF): No repeating groups or arrays; each cell contains a single value.
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2nd Normal Form (2NF): 1NF + all non-key attributes are fully dependent on the primary key.
3rd Normal Form (3NF): 2NF + no transitive dependency (non-key attribute depends only on the
primary key).
Example:
Suppose a table stores student info and their courses:

After 1NF:

After 2NF and 3NF: Further split tables to ensure all attributes depend only on the primary key.

Summary Table

Concept Description
DBMS Software to manage databases, ensure security, integrity,

and multi-user access
SQL Language for creating, modifying, querying databases
ER Diagram Visual tool for database design, showing entities and

relationships
Normalization Steps to organize data, remove redundancy, and ensure

integrity

In summary:
A DBMS provides a secure, structured way to store and manage data. SQL is the language used tointeract with these systems. ER diagrams help design the database structure, and normalization ensuresthe data is organized efficiently and without unnecessary duplication
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Topic 6: Networking: OSI model, TCP/IP, LAN/WAN,
Internet basics, network devices, security.
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1. Introduction to Computer Networks
A computer network is a collection of connected computers and devices that share resources
and information. Networking allows communication, data sharing, and access to the internet.
2. OSI Model (Open Systems Interconnection Model)
The OSI model is a theoretical framework that standardizes the functions of a network into
seven layers. Each layer serves a specific purpose in the communication process.
Seven Layers of the OSI Model:
1. Physical Layer:

Deals with the physical connection (cables, switches, signals).
Transmits raw bits over the medium.

2. Data Link Layer:
Ensures reliable node-to-node data transfer.
Handles MAC addressing and error detection (e.g., Ethernet).

3. Network Layer:
Manages routing of data (logical addressing, e.g., IP addresses).
Responsible for packet forwarding.

4. Transport Layer:
Provides reliable data transfer (e.g., TCP, UDP).
Handles error correction and flow control.

5. Session Layer:
Manages sessions (connections) between applications.

6. Presentation Layer:
Translates data formats, encrypts/decrypts, compresses data.

7. Application Layer:
Closest to the user; provides network services (e.g., HTTP, FTP, SMTP).

Purpose:
The OSI model helps in understanding, designing, and troubleshooting networks by dividing
tasks into manageable layers.
3. TCP/IP Model
The TCP/IP model is the practical framework used for real-world networking and the internet. It
has four layers:
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1. Application Layer:
Combines OSI’s Application, Presentation, and Session layers.
Protocols: HTTP, FTP, SMTP, DNS.

2. Transport Layer:
Provides end-to-end communication.
Protocols: TCP (reliable), UDP (faster, less reliable).

3. Internet Layer:
Handles logical addressing and routing (IP protocol).
Protocols: IP, ICMP.

4. Network Access Layer:
Combines OSI’s Data Link and Physical layers.
Deals with hardware addressing and media access.

Key Point:
TCP/IP is the backbone of the internet; OSI is mainly used for conceptual understanding and
troubleshooting.
5. LAN, WAN, and Other Networks
LAN (Local Area Network):

Covers a small area (e.g., office, school).
High speed, low error rate.
Example: School computer lab.

WAN (Wide Area Network):
Covers a large area (e.g., cities, countries).
Connects multiple LANs using routers and leased lines.
Example: The Internet.

MAN (Metropolitan Area Network):
Covers a city or campus.
Larger than LAN, smaller than WAN.

6. Internet Basics
Internet:

A global network connecting millions of computers.
Uses TCP/IP protocols for communication.
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World Wide Web (WWW):
A service on the internet for accessing web pages via browsers.

IP Address:
Unique identifier for devices on a network.

Protocols:
Set of rules for communication (e.g., HTTP, FTP, SMTP, DNS).

7. Network Devices
Common Network Devices and Their Functions:

Device Function
Hub Connects multiple computers in a network; broadcasts data to

all devices.
Switch Connects devices; forwards data only to the intended device.
Router Connects different networks (e.g., LAN to Internet); routes data

packets.
Bridge Connects and filters traffic between two network segments.
Gateway Connects networks with different protocols; translates data

formats.
Repeater Amplifies signals to extend network range.
Modem Converts digital data to analog for transmission over phone

lines.
Access Point Allows wireless devices to connect to a wired network.
Load Balancer Distributes network traffic across multiple servers.

7. Network Security
Why is Security Important?
To protect data and devices from unauthorized access, viruses, and cyberattacks.
Key Security Concepts:
Firewalls:
Hardware/software that filters incoming and outgoing network traffic.
Blocks unauthorized access while permitting legitimate communication.
Antivirus Software:
Detects and removes malicious software (malware, viruses).
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Backup and Restore:
Regularly saving data copies for recovery after failures or attacks.
Authentication:
Verifying user identity before granting network access.
Encryption:
Converting data into unreadable code to protect privacy.
Ethical Hacking:
Testing networks for vulnerabilities to improve security.
8. Summary Table: OSI vs TCP/IP Model

OSI Model (7 Layers) TCP/IP Model (4 Layers)Application ApplicationPresentation
Session
Transport TransportNetwork InternetData Link Network AccessPhysical

9. Key Points for BPSC TRE 4.0 Exam
Understand the purpose and functions of each OSI and TCP/IP layer.
Know the differences between LAN, WAN, and MAN.
Be able to identify and explain the use of common network devices.
Grasp basic internet concepts and common protocols.

Remember essential security practices and devices.
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Topic 7: Web Technologies: HTML, CSS, Basics of JavaScript,
Internet and WWW
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1. Introduction to Web Technologies
Web technologies are the tools and languages that power the World Wide Web (WWW). They
allow us to create, design, and interact with websites and web applications. The three core
technologies are HTML, CSS, and JavaScript. Understanding these, along with Internet and
WWW basics, is essential for any computer teacher.
2. Internet and World Wide Web (WWW)

 Internet is a global network connecting millions of computers for sharing information,
resources, and communication.

 WWW (World Wide Web) is a service on the Internet that provides access to web pages
using web browsers (like Chrome, Firefox, Safari).

 Web Browser: Software to access and view websites (e.g., Chrome, Firefox, Edge).
 Web Server: A computer that stores and serves web pages to users.
 URL (Uniform Resource Locator): The address used to access a web page (e.g.,

https://www.bpsc.bih.nic.in).
 HTTP/HTTPS: Protocols used to transfer web data; HTTPS is the secure version.
 Search Engine: A tool to find information on the web (e.g., Google, Bing).

1. HTML (HyperText Markup Language)
HTML is the standard language for creating web pages and web applications.
Structure: HTML uses tags to mark up content. Tags are enclosed in angle brackets < >.
Basic Structure of an HTML Document:
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Common HTML Tags:
<html>: Root element
<head>: Contains meta information, title, links to CSS/JS
<title>: Title of the page (shown in browser tab)
<body>: Main content of the page
<h1> to <h6>: Headings
<p>: Paragraph
<a href="URL">: Hyperlink
<img src="image.jpg">: Image
<ul>, <ol>, <li>: Lists (unordered, ordered, list item)
<table>, <tr>, <td>, <th>: Tables
Attributes: Provide additional information about tags (e.g., src, href, alt).

2. CSS (Cascading Style Sheets)
 CSS is used to style and layout web pages (colors, fonts, spacing, positioning).
 How CSS Works: CSS can be included in three ways:

Inline: Directly in the HTML element (not recommended for large projects)

Internal: Inside a <style> tag in the <head>

External: In a separate .css file linked to HTML
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Basic Syntax:

Example:

 Selectors: Target HTML elements (e.g., h1, .class, #id).

5. Basics of JavaScript
 JavaScript is a scripting language that makes web pages interactive and dynamic. Uses: Form validation, animations, dynamic content, responding to user actions.How to Use JavaScript:

Inline: Inside HTML elements (not recommended for large projects)
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Internal: Inside a <script> tag in HTML

External: In a separate .js file linked to HTML

Basic Syntax:

 Variables: var, let, const
Functions:

 Events: Actions like click, mouseover, etc.
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6. How HTML, CSS, and JavaScript Work Together
 HTML provides the structure. CSS provides the style (look and feel). JavaScript provides interactivity (behavior). All three are essential for modern web development and are asked in BPSC TRE exams.

7. Internet and Web Concepts for Teachers
 Client-Server Model: The browser (client) requests web pages from the server. Static vs. Dynamic Web Pages: Static pages use only HTML/CSS; dynamic pages use JavaScriptand server-side scripting. Web Publishing: The process of uploading web pages to a web server so they are accessible onthe Internet.
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Topic 8: MS Office Suite: Word, Excel, PowerPoint, and PracticalApplications in Education
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1. Introduction to MS Office Suite
Microsoft Office Suite is a collection of powerful productivity tools widely used in schools, colleges,offices, and homes. The main applications are:

 Word: For creating and editing documents. Excel: For working with spreadsheets and data analysis. PowerPoint: For making presentations. Outlook: For email and scheduling. OneNote, Access, Publisher: For note-taking, database management, and publishing. Modern versions are available as Microsoft 365 (cloud-based, subscription) or as standaloneOffice 2019/2021.
2. Microsoft Word
Purpose: Word processing (letters, reports, assignments, notices).
Key Features: Document Creation: Type, edit, and format text. Formatting: Change font, size, color, alignment, and spacing. Styles & Templates: Use pre-designed templates for resumes, letters, etc. Tables & Charts: Insert tables, charts, and SmartArt for data organization. Mail Merge: Send personalized letters/emails to multiple recipients. Collaboration: Multiple users can edit documents in real time (with OneDrive). Review Tools: Spell check, grammar check, comments, and track changes. Accessibility: Immersive Reader, Dictation, and Accessibility Checker for inclusive documents.
Educational Uses:
Preparing assignments, question papers, and certificates.Creating newsletters, circulars, and official letters.Collaborative editing for group projects.
3. Microsoft Excel
Purpose: Spreadsheet management, calculations, and data analysis.
Key Features: Worksheets: Organize data in rows and columns (cells). Formulas & Functions: Perform calculations (SUM, AVERAGE, IF, VLOOKUP). Charts & Graphs: Visualize data using bar, line, pie charts, etc. Data Analysis: Use PivotTables, filters, and conditional formatting for insights. Templates: Ready-made templates for attendance, marksheets, budgets. Automation: Use Macros to automate repetitive tasks. Collaboration: Share and co-edit files online.
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Educational Uses:
Maintaining student attendance and marksheets.Analyzing exam results and generating reports.Creating timetables and schedules.Teaching basic data analysis and graphing skills.
4. Microsoft PowerPoint
Purpose: Creating and delivering presentations.
Key Features:

 Slides: Organize content into slides for step-by-step presentation. Design Tools: Use themes, templates, and layouts for professional look. Multimedia: Insert images, audio, video, and animations. Transitions & Animations: Add movement to slides and elements. Presenter View: View notes and upcoming slides while presenting. Collaboration: Multiple users can build and edit presentations together. Accessibility: Dictation, voice commands, and improved PDF exports for accessibility.
Educational Uses:
Teaching lessons with visual aids.Student projects and seminar presentations.Creating interactive quizzes and e-learning content.Demonstrating concepts with diagrams and animations.
5. Practical Applications in Education

 Assignments & Reports: Word is used for writing and formatting assignments, reports, andstudy materials. Data Management: Excel helps track attendance, grades, and analyze student performance. Classroom Presentations: PowerPoint makes lessons engaging with visuals, animations, andmultimedia. Collaboration: Office 365/OneDrive allows teachers and students to work together ondocuments and presentations in real time. Accessibility: New features support inclusive education, making materials usable for allstudents. Assessment: Excel can generate automatic result sheets and analyze class performance. Communication: Word and PowerPoint help in preparing notices, newsletters, and circulars forparents and students.
6. Tips and Best Practices (2025 Updates)

 Use Templates: Save time with pre-made templates for common educational tasks. Leverage Accessibility Tools: Use Immersive Reader, Accessibility Checker, and alt text forinclusive documents.
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 Integrate Cloud Storage: Save and share files via OneDrive for easy access anywhere. Collaborate in Real Time: Use co-authoring features for group work and peer review. Automate Tasks: Use Macros in Excel to speed up repetitive processes. Stay Updated: Microsoft 365 provides regular updates with new features and securityenhancements.
7. Summary Table
Application Main Use in Education Key FeaturesWord Documents, assignments, letters Formatting, tables, mail merge,accessibilityExcel Data analysis, marks, attendance Formulas, charts, PivotTables,conditional formattingPowerPoint Presentations, lessons, projects Slides, multimedia, transitions,collaboration

Practical Applications in Teaching
Application Practical Use in Teaching Example Activities
Word Lesson plans, worksheets,

assignments
Create tests, handouts,
feedback forms

Excel Grades, attendance, data
analysis

Track marks, analyze
trends, make charts

PowerPoint Visual lessons, interactive
quizzes

Present topics, create
student presentations

8. Conclusion
MS Office Suite is essential for modern teaching and learning. Mastering Word, Excel, and PowerPointhelps teachers create professional documents, analyze data, and deliver engaging lessons, while alsopreparing students for future academic and professional needs.

Topic 9: Computer Security: Viruses, Malware, Firewalls, SafePractices"
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1. Introduction to Computer Security
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Computer security refers to the protection of computer systems and data from theft, damage,unauthorized access, and other cyber threats. It is essential for safeguarding personal, educational, andorganizational information.
2. Viruses and Malware
A. Computer Viruses

 Definition: A computer virus is a malicious program that attaches itself to other programs orfiles and spreads from one computer to another, often causing harm.
 How Viruses Spread: Through infected email attachments, downloads, USB drives, or maliciouswebsites.
 Effects: Can corrupt files, steal data, slow down systems, or make computers unusable.

B. MalwareDefinition: "Malware" stands for "malicious software" and is a broad term for any software designed toharm, exploit, or illegally access computers or networks.
Types of Malware:

 Virus: Attaches to files and replicates. Worm: Spreads independently across networks. Trojan Horse: Disguises as legitimate software but harms when executed. Spyware: Secretly monitors user activity and collects information. Adware: Displays unwanted advertisements. Ransomware: Locks data and demands payment for release. Rootkit: Hides malicious activity from detection. Keylogger: Records keystrokes to steal passwords and data.
3. Firewalls
Definition: A firewall is a security device (hardware or software) that monitors and controls incomingand outgoing network traffic based on predetermined security rules.
Types:
Software Firewall: Installed on individual computers (e.g., Windows Firewall).Hardware Firewall: A physical device placed between the network and gateway.
Functions:

 Blocks unauthorized access to or from a private network. Filters harmful traffic and prevents cyberattacks. Can be configured to allow or deny specific traffic.
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4. Safe Practices for Computer Use
A. Preventing Virus and Malware Infections

 Install Antivirus Software: Use reputable antivirus and keep it updated. Regular Scans: Scan your computer regularly for threats. Update Software: Keep your operating system and all applications up to date with the latestsecurity patches. Be Cautious with Email Attachments: Do not open attachments or click links from unknown orsuspicious sources. Download from Trusted Sources: Only install software from official websites or trusted vendors. Use Strong Passwords: Create complex passwords and change them regularly. Backup Data: Regularly backup important files to external drives or cloud storage. Avoid Pirated Software: Pirated programs often contain malware.
B. Safe Internet Practices

 Use Secure Websites: Look for "https://" in the address bar. Do Not Share Personal Information: Avoid sharing sensitive data on public or untrusted sites. Be Wary of Pop-Ups and Ads: Do not click on suspicious advertisements or pop-ups. Logout After Use: Always log out from online accounts after use, especially on sharedcomputers. Enable Two-Factor Authentication: Adds an extra layer of security for accounts.
C. Physical Security

 Lock Your Device: Use passwords or PINs to lock computers and devices. Restrict Physical Access: Prevent unauthorized people from using your computer.
5. Importance of Computer Security in Education

 Protects Student and Staff Data: Prevents unauthorized access to personal and academicrecords. Ensures Safe Learning Environment: Shields school computers and networks from cyberthreats. Promotes Responsible Digital Citizenship: Teaches students about safe and ethical use oftechnology.

6. Summary Table
Concept Description/Example
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Virus Infects files, spreads by attaching to programsMalware Includes viruses, worms, trojans, spyware, ransomware, etc.Firewall Blocks unauthorized access, filters network trafficSafe Practices Antivirus, updates, strong passwords, cautious browsing
7. Key Points
Know definitions and types of malware and viruses.Understand how firewalls work and their types.Learn and apply safe computing and internet practices.Emphasize the importance of security in educational settings.

Topic 10: ICT in Education: Role of computers in teaching, e-learningtools, digital classroom management
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1. Role of Computers in Teaching
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A. Transforming the Teaching-Learning Process
 Interactive Learning: Computers make lessons more engaging through multimediapresentations, simulations, and educational games. Access to Information: Teachers and students can access a vast range of information, e-books,and online resources. Personalized Learning: Adaptive software tailors content to individual student needs andlearning speeds. Efficient Assessment: Digital tools allow for quick quizzes, instant feedback, and automatedgrading. Collaboration: Computers enable group projects and peer learning through shared documentsand online forums. Distance & Blended Learning: Computers support both remote (online) and blended (online +classroom) learning models.

B. Practical Uses in Schools Creating lesson plans, worksheets, and tests. Demonstrating concepts using animations and videos. Maintaining student records and grades. Communicating with parents and students via email or online portals.
2. E-Learning Tools
E-learning tools are software and platforms that support digital teaching and learning. They makeeducation more accessible, engaging, and effective.
A. Learning Management Systems (LMS)
Definition: Centralized platforms for creating, delivering, and managing instructional content.Examples: Google Classroom, Canvas, Schoology.
Features:
Assignment distribution and submission.Gradebooks for tracking student progress.Communication tools (announcements, messaging, discussion boards).Resource sharing (lesson plans, videos, readings).Accessibility for in-person, hybrid, and online learning.

B. Classroom Response SystemsDefinition: Tools for real-time student feedback.Examples: Kahoot!, Quizlet, Socrative.Benefits: Increases engagement, provides instant assessment, and helps tailor instruction.
C. Collaboration ToolsDefinition: Enable teamwork and communication among students and teachers.Examples: Google Workspace (Docs, Sheets, Slides), Microsoft Teams, Padlet.
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Features: Real-time document editing, group workspaces, file sharing, and integration with other tools.
D. Digital Assessment ToolsDefinition: Platforms for creating and grading quizzes, tests, and assignments.Examples: Edulastic (now Pear Assessment), Formative, Quizizz.Benefits: Automated grading, detailed analytics, and personalized feedback.
E. Behavior Management ToolsDefinition: Track and encourage positive student behavior.Examples: ClassDojo, Kickboard, LiveSchool.Features: Behavior tracking, communication with parents, reward systems.
F. Interactive Whiteboards and ScreensDefinition: Digital boards for drawing, presenting, and interacting with content.Examples: Classroomscreen, Gynzy.Features: Timers, group makers, polls, drawing tools, and more.
G. Assistive TechnologyDefinition: Tools for students with special needs.Examples: Livescribe smartpens, screen readers.Features: Converts handwriting to digital text, audio recording, and playback.
3. Digital ClassroomManagement
Digital classroom management involves using technology to organize, monitor, and enhance thelearning environment.
A. Key Digital Management ToolsLMS (Google Classroom, Canvas): Centralizes assignments, grades, and communication.Mobile Device Management (MDM): Controls student device usage, restricts apps, and monitorsactivity.Classroom Response and Behavior Tools: Monitor participation and encourage positive actions.
B. BenefitsEfficiency: Automates routine tasks (grading, attendance, resource sharing).Transparency: Keeps students and parents informed.Accessibility: 24/7 access to materials and grades.Engagement: Interactive lessons and instant feedback.
Safety: Monitors digital behavior and ensures a secure online environment.
C. Best PracticesSet clear digital rules and expectations.Use digital tools consistently for assignments and communication.Encourage student participation through polls, quizzes, and collaborative projects.Monitor device and internet usage to prevent distractions.Foster a positive digital culture—respect, responsibility, and safety online.
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3. Summary Table: Key ICT Tools in Education
Tool Type Examples Main UseLMS Google Classroom, Canvas Assignment management, grades,communicationCollaboration Tools Google Docs, Teams, Padlet Group work, real-time editingResponse Systems Kahoot!, Quizizz, Socrative Instant feedback, quizzesAssessment Tools Edulastic, Formative Online tests, analyticsBehavior Tools ClassDojo, LiveSchool Track/reward behavior, parent updatesInteractive Boards Classroomscreen, Gynzy Visual lessons, engagementMDM Trio MDM, Google AdminConsole Device monitoring, security

5. Conclusion
ICT in education has revolutionized teaching and learning by making classrooms more interactive,inclusive, and efficient. Teachers equipped with digital tools can enhance lesson delivery, studentengagement, assessment, and classroom management. For BPSC TRE 4.0, focus on understanding howthese tools work and their practical benefits in real classroom scenarios.

Topic 11: Recent Trends: Cloud Computing, Artificial IntelligenceBasics, IoT, Digital India Initiatives
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1. Cloud Computing
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A. Definition and Overview
Cloud computing is the delivery of computing services—including servers, storage, databases,networking, software, analytics, and intelligence—over the Internet (“the cloud”) to offer fasterinnovation, flexible resources, and economies of scale.
B. Key Trends in 2025

 Multi-Cloud and Hybrid Cloud: Organizations use multiple cloud providers and combine public,private, and on-premises infrastructures for flexibility, cost savings, and to avoid vendor lock-in.This improves data security, compliance, and seamless workload management.
 Cloud-Native Architecture: By 2025, most new applications will be built using microservices,containers, and Kubernetes, making them more agile, scalable, and resilient.
 AI-Powered Cloud Services: Cloud platforms increasingly integrate AI and machine learning,automating processes, enabling predictive analytics, and enhancing decision-making.
 Edge Computing: Computation is moving closer to data sources (like IoT devices), reducinglatency and supporting real-time applications such as autonomous vehicles and smartclassrooms.
 Quantum Cloud Computing: Emerging technology that uses quantum computers for complexcomputations, offering exponential speed and efficiency improvements for data processing.
 Sustainability: Cloud providers are investing in energy-efficient, carbon-neutral data centers andAI-driven power management to support environmental goals.

C. Applications in Education
 Online storage and sharing of resources (Google Drive, OneDrive). Cloud-based learning platforms (Google Classroom, Microsoft Teams). Real-time collaboration on documents and projects. Scalable access to educational software and virtual labs.

2. Artificial Intelligence (AI) Basics
A. DefinitionArtificial Intelligence (AI) is a branch of computer science that aims to create systems capable ofperforming tasks that typically require human intelligence, such as understanding language, recognizingpatterns, and making decisions.
B. Key Concepts
Types of AI:

 Narrow AI: Performs specific tasks (e.g., voice assistants, chatbots). General AI: Hypothetical, would perform any intellectual task a human can do.
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 Superintelligent AI: Beyond human intelligence (theoretical).
Domains of AI:

 Natural Language Processing (NLP): Understanding and processing human language (e.g.,chatbots, translation tools). Computer Vision: Analyzing and interpreting visual data (e.g., facial recognition, self-drivingcars). Data Science: Extracting insights from data using AI techniques. Machine Learning (ML): A subset of AI where machines learn from data to improveperformance without explicit programming. Deep Learning (DL): A type of ML using neural networks for complex tasks like image andspeech recognition.
C. Applications in Education

 Personalized learning and adaptive assessments. AI-powered tutors and chatbots for student support. Automated grading and feedback. Predictive analytics for student performance and dropout prevention.
D. Ethical Considerations Data privacy and security. Bias and fairness in AI algorithms. Job displacement and the need for new skills.
3. Internet of Things (IoT)
A. Definition
The Internet of Things (IoT) refers to a network of physical devices (“things”) embedded with sensors,software, and connectivity, enabling them to collect and exchange data.
B. Applications in Education

 Smart Classrooms: Use of sensors and connected devices for attendance, lighting, and climatecontrol.
 Real-Time Monitoring: Track student engagement, automate attendance (RFID), and monitorcampus security. Personalized Learning: AI-powered analytics from IoT devices help teachers adjust lessonsbased on student progress. Resource Management: Automated control of lights, HVAC, and energy usage for cost savingsand sustainability. Campus Safety: Connected cameras, access controls, and emergency systems. Asset Tracking: Managing educational equipment and resources efficiently.

C. Advantages
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 Enhanced safety and security. Improved energy efficiency. Data-driven decision making for teachers and administrators. More interactive and personalized learning environments.
4. Digital India Initiatives
A. OverviewDigital India is a flagship program launched by the Government of India to transform the country into adigitally empowered society and knowledge economy.
B. Key Initiatives (2024-2025 Focus)Centre of Excellence in AI for Education: ₹500 crore allocated for developing AI-powered tools, adaptiveassessments, and smart administration in education.

 Broadband Connectivity for Rural Schools: Expansion of BharatNet to provide high-speedinternet to all government secondary schools in rural areas, bridging the digital divide.
 Digital Language Books (Bharatiya Bhasha Pustak Scheme): Digital textbooks in multiple Indianlanguages to promote inclusivity and multilingual education.
 National Centres of Excellence for Skilling: Partnerships with global institutions to impart digitalskills and online certifications.
 Expansion of Atal Tinkering Labs: 50,000 new labs in government schools to boost STEMeducation, coding, and problem-solving skills.

C. Other Notable Programs SWAYAM: Free online courses for students and teachers. DIKSHA: Digital infrastructure for school education, offering e-content and teacher training. PM eVidya: Multi-platform digital learning initiative for students across India.
D. Impact Improved access to quality digital education, especially in rural and underserved areas. Promotion of AI, coding, and digital literacy from an early age. Support for inclusive, multilingual, and skill-based learning.
5. Summary Table
Trend/Technology Key Features/Applications in EducationCloud Computing Online storage, collaboration, virtual labs, scalable resourcesArtificial Intelligence Personalized learning, AI tutors, automated assessmentIoT Smart classrooms, real-time monitoring, campus safetyDigital India Broadband for schools, AI in education, digital content, skilling
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6. Conclusion
Understanding these recent trends is essential for modern educators. Cloud computing, AI, and IoT aretransforming how schools operate and how students learn. Digital India initiatives are making thesetechnologies accessible, aiming to bridge gaps and prepare students for the digital future.
Tip for BPSC TRE 4.0:
Focus on definitions, practical applications in education, and government initiatives. Use real-lifeexamples and be ready to discuss the impact of these technologies on teaching and learning.
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Topic 1: Fundamentals of Computers: History, types,
generations, hardware, software, I/O devices.

1. Who is known as the father of computers?
A) Charles BabbageB) Alan TuringC) John von NeumannD) Bill GatesAnswer: A2. Which device is used to convert hard copy tosoft copy?A) PrinterB) ScannerC) MonitorD) SpeakerAnswer: B3. Which generation used vacuum tubes?A) FirstB) SecondC) ThirdD) FourthAnswer: A4. The brain of the computer is:A) RAMB) CPUC) MonitorD) KeyboardAnswer: B

5. Which is not an input device?A) MouseB) KeyboardC) MonitorD) ScannerAnswer: C6. Which is a secondary storage device?A) RAMB) ROMC) Hard DiskD) CacheAnswer: C7. Which language was used in first generationcomputers?A) AssemblyB) MachineC) High LevelD) Both A and BAnswer: D8. Which of the following is applicationsoftware?A) WindowsB) MS WordC) LinuxD) DOSAnswer: B9. Which device is used to display output?A) PrinterB) KeyboardC) MouseD) ScannerAnswer: A10. Which is a pointing device?A) MouseB) KeyboardC) PrinterD) MonitorAnswer: A11. The first electronic computer was:A) UNIVACB) ENIACC) EDSACD) EDVACAnswer: B
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12. Which is not a type of computer?A) AnalogB) DigitalC) HybridD) ManualAnswer: D13. Which is volatile memory?A) ROMB) RAMC) Hard DiskD) CDAnswer: B14. The main function of ALU is:A) Store dataB) Perform arithmetic and logic operationsC) Display outputD) Control instructionsAnswer: B15. Which is not a hardware device?A) MonitorB) MouseC) MS ExcelD) PrinterAnswer: C16. Which is the smallest unit of data in acomputer?A) ByteB) BitC) NibbleD) WordAnswer: B17. Which generation introducedmicroprocessors?A) FirstB) SecondC) ThirdD) FourthAnswer: D18. Which of the following is system software?A) MS WordB) ExcelC) WindowsD) PowerPointAnswer: C19. Which is not an output device?A) MonitorB) PrinterC) Speaker

D) KeyboardAnswer: D20. Which is a storage device?A) MouseB) MonitorC) Hard DiskD) SpeakerAnswer: C21. The full form of CPU is:A) Central Processing UnitB) Central Programming UnitC) Central Processor UtilityD) Central Power UnitAnswer: A22. The main memory is also called:A) Secondary MemoryB) Primary MemoryC) External MemoryD) Flash MemoryAnswer: B23. Which is not a computer language?A) BASICB) COBOLC) FORTRAND) MS WordAnswer: D24. The first mechanical computer designed byCharles Babbage was:A) Analytical EngineB) AbacusC) ENIACD) PascalineAnswer: A25. Which is a type of ROM?A) PROMB) EPROMC) EEPROMD) All of the aboveAnswer: D26. The device that connects a computer to anetwork is called:A) ModemB) PrinterC) MouseD) ScannerAnswer: A27. Which of the following is not a type ofnumber system?
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A) DecimalB) BinaryC) HexadecimalD) FractionalAnswer: D28. The process of starting a computer iscalled:A) FormattingB) BootingC) InstallingD) ExecutingAnswer: B29. Which is a graphical input device?A) Light PenB) KeyboardC) PrinterD) SpeakerAnswer: A30. Which is not a function of an operatingsystem?A) Memory ManagementB) Process ManagementC) Data ProcessingD) Device ManagementAnswer: C31. Which is an example of applicationsoftware?A) MS ExcelB) WindowsC) LinuxD) DOSAnswer: A32. Which part of the computer is responsiblefor calculations?A) CUB) ALUC) RAMD) ROMAnswer: B33. Which is not a storage device?A) Pen DriveB) Hard DiskC) RAMD) MonitorAnswer: D34. The main circuit board of a computer is:A) RAMB) Motherboard

C) CPUD) Hard DiskAnswer: B35. Which is a portable storage device?A) Hard DiskB) RAMC) Pen DriveD) ROMAnswer: C36. Which is not a type of printer?A) LaserB) InkjetC) Dot MatrixD) LCDAnswer: D37. Which is not a type of monitor?A) CRTB) LEDC) LCDD) HDDAnswer: D38. The control unit is a part of:A) ALUB) CPUC) RAMD) ROMAnswer: B39. Which is not a function of RAM?A) Temporary storageB) Permanent storageC) Fast accessD) Volatile memoryAnswer: B40. Which is not a type of computer?A) MainframeB) SupercomputerC) MinicomputerD) MicrophoneAnswer: D41. The first computer language was:A) BASICB) FORTRANC) Machine LanguageD) CAnswer: C42. Which is not a type of software?A) ApplicationB) System
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C) UtilityD) HardwareAnswer: D43. Which device is used for gaming input?A) KeyboardB) JoystickC) PrinterD) MonitorAnswer: B44. Which is not a type of RAM?A) DRAMB) SRAMC) PROMD) NoneAnswer: C45. Which is not a type of ROM?A) PROMB) EPROMC) EEPROMD) SRAMAnswer: D46. The smallest unit of memory is:A) BitB) ByteC) NibbleD) WordAnswer: A47. Which is an example of a hybrid computer?A) LaptopB) ECG MachineC) DesktopD) TabletAnswer: B48. Which is not a pointing device?A) MouseB) Light PenC) TouchpadD) PrinterAnswer: D49. Which is used to store data permanently?A) RAMB) ROMC) Hard DiskD) CacheAnswer: C50. The main function of a scanner is:A) Print documentsB) Scan images

C) Display outputD) Store dataAnswer: B51. Which is not a generation of computers?A) FirstB) SecondC) ThirdD) SixthAnswer: D52. Which is a non-volatile memory?A) RAMB) ROMC) CacheD) RegisterAnswer: B53. Which is not a function of CU?A) Control operationsB) Arithmetic operationsC) Instruction decodingD) Directing data flowAnswer: B54. Which is not a type of applicationsoftware?A) Word ProcessorB) SpreadsheetC) Operating SystemD) PresentationAnswer: C55. Which is not a type of system software?A) CompilerB) Operating SystemC) MS WordD) Device DriverAnswer: C56. Which is not a type of secondary storage?A) SSDB) CDC) RAMD) Pen DriveAnswer: C57. The process of copying files from computerto internet is:A) DownloadingB) UploadingC) FormattingD) InstallingAnswer: B58. Which is not a function of a computer?
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A) InputB) OutputC) ProcessingD) SleepingAnswer: D59. Which is not a binary number?A) 101B) 1101C) 202D) 111Answer: C60. Which is not a type of number system?A) BinaryB) DecimalC) OctalD) DigitalAnswer: D61. The first commercial computer was:A) ENIACB) UNIVACC) EDSACD) EDVACAnswer: B62. Which is not a feature of computers?A) SpeedB) AccuracyC) DiligenceD) IntelligenceAnswer: D63. Which is not a storage device?A) Floppy DiskB) Hard DiskC) MonitorD) CDAnswer: C64. Which is not a function of a printer?A) PrintB) ScanC) CopyD) DisplayAnswer: D65. Which is not a type of computer monitor?A) CRTB) LCDC) LEDD) HDDAnswer: D66. Which is not a type of computer memory?

A) RAMB) ROMC) DVDD) CacheAnswer: C67. Which is not a function of an OS?A) File ManagementB) Device ManagementC) Process ManagementD) Arithmetic OperationsAnswer: D68. Which is not a computer peripheral?A) MouseB) KeyboardC) CPUD) PrinterAnswer: C69. Which is not a type of keyboard?A) QWERTYB) AZERTYC) DVORAKD) LCDAnswer: D70. Which is not a computer port?A) USBB) HDMIC) VGAD) LEDAnswer: D71. Which is not a function of the mouse?A) PointingB) ClickingC) TypingD) DraggingAnswer: C72. Which is not a type of scanner?A) FlatbedB) HandheldC) DrumD) CRTAnswer: D73. Which is not a function of a microphone?A) Input soundB) Output soundC) Record voiceD) NoneAnswer: B74. Which is not a type of printer?
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A) LaserB) InkjetC) Dot MatrixD) LED MonitorAnswer: D75. Which is not a type of software?A) ApplicationB) SystemC) UtilityD) HardwareAnswer: D76. Which is not a type of input device?A) MouseB) KeyboardC) MonitorD) ScannerAnswer: C77. Which is not a type of output device?A) MonitorB) PrinterC) SpeakerD) KeyboardAnswer: D78. Which is not a type of storage device?A) Hard DiskB) Pen DriveC) MouseD) CDAnswer: C79. Which is not a function of a computer?A) InputB) OutputC) ProcessingD) SleepingAnswer: D80. Which is not a type of memory?A) RAMB) ROMC) CPUD) CacheAnswer: C81. Which is not a computer language?A) BASICB) COBOLC) FORTRAND) MS WordAnswer: D82. Which is not a type of computer?

A) MainframeB) SupercomputerC) MinicomputerD) MicrophoneAnswer: D83. Which is not a feature of computers?A) SpeedB) AccuracyC) DiligenceD) IntelligenceAnswer: D84. Which is not a function of the CPU?A) ProcessingB) StorageC) ControlD) ArithmeticAnswer: B85. Which is not a type of storage device?A) Hard DiskB) Pen DriveC) MouseD) CDAnswer: C86. Which is not a function of RAM?A) Temporary storageB) Permanent storageC) Fast accessD) Volatile memoryAnswer: B87. Which is not a type of ROM?A) PROMB) EPROMC) EEPROMD) SRAMAnswer: D88. Which is not a type of printer?A) LaserB) InkjetC) Dot MatrixD) LCDAnswer: D89. Which is not a type of monitor?A) CRTB) LEDC) LCDD) HDDAnswer: D90. Which is not a type of computer?
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A) MainframeB) SupercomputerC) MinicomputerD) MicrophoneAnswer: D91. Which is not a function of the mouse?A) PointingB) ClickingC) TypingD) DraggingAnswer: C92. Which is not a type of scanner?A) FlatbedB) HandheldC) DrumD) CRTAnswer: D93. Which is not a function of a microphone?A) Input soundB) Output soundC) Record voiceD) NoneAnswer: B94. Which is not a type of printer?A) LaserB) InkjetC) Dot MatrixD) LED MonitorAnswer: D95. Which is not a function of the control unit?A) Control operationsB) Arithmetic operationsC) Instruction decoding

D) Directing data flowAnswer: B96. Which is not a function of the ALU?A) Arithmetic operationsB) Logic operationsC) StorageD) NoneAnswer: C97. Which is not a type of computer memory?A) RAMB) ROMC) DVDD) CacheAnswer: C98. Which is not a function of an OS?A) File ManagementB) Device ManagementC) Process ManagementD) Arithmetic OperationsAnswer: D99. Which is not a computer peripheral?A) MouseB) KeyboardC) CPUD) PrinterAnswer: C100. Which is not a type of keyboard?A) QWERTYB) AZERTYC) DVORAKD) LCDAnswer: D
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MCQ Topic 2: Operating Systems: Windows, Linux, Basic
Commands, and File Management

1. What is the main function of an operatingsystem?A) Compiling programsB) Managing hardware and software resourcesC) Creating websitesD) Printing documentsAnswer: B2. Which of the following is NOT an operatingsystem?A) WindowsB) LinuxC) OracleAnswer: C3. Windows is developed by:A) AppleB) MicrosoftC) GoogleD) IBMAnswer: B4. Which of the following is a Linuxdistribution?A) UbuntuB) Windows 10

C) macOSD) AndroidAnswer: A5. What is the core of the Linux operatingsystem?A) ShellB) KernelC) CommandD) ScriptAnswer: B6. Which among the following interactsdirectly with system hardware?A) ShellB) KernelC) CommandsD) ApplicationsAnswer: B7. Which command is used to display thecurrent working directory in Linux?A) cdB) lsC) pwdD) dirAnswer: C8. Which command is used to list all files anddirectories in Linux?A) lsB) dirC) listD) showAnswer: A9. In Windows, which tool is used to managefiles and folders?A) TaskbarB) File ExplorerC) Control PanelD) PaintAnswer: B10. Which command is used to changedirectory in both Windows and Linux?A) chdirB) cdC) dir
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D) moveAnswer: B11. Which command in Linux is used to createan empty file?A) createB) mkfileC) touchD) makeAnswer: C12. What is the default file system for mostLinux distributions?A) NTFSB) FAT32C) ext4D) HFS+Answer: C13. Which command is used to remove a file inLinux?A) delB) rmC) eraseD) removeAnswer: B14. Which command is used to remove adirectory with all its subdirectories in Linux?A) rm -bB) rm -oC) rm -pD) rm -rAnswer: D15. Which command is used to copy files inLinux?A) copyB) cpC) mvD) cutAnswer: B16. In Windows, which shortcut is used to copyfiles?A) Ctrl+XB) Ctrl+VC) Ctrl+CD) Ctrl+ZAnswer: C17. Which Linux command is used to move orrename files?A) mvB) cp

C) moveD) renAnswer: A18. Which command displays the contents of afile in Linux?A) showB) displayC) catD) openAnswer: C19. Which command is used to print a file inLinux?A) printB) prC) lpD) outAnswer: C20. Which command is used to display diskusage in Linux?A) duB) dsC) ddD) ddsAnswer: A21. Which command is used to count lines,words, and characters in a file in Linux?A) grepB) wcC) countD) cutAnswer: B22. Which command is used to add a new userin Linux?A) adduserB) useraddC) newuserD) Both A and BAnswer: D23. Which command is used to change filepermissions in Linux?A) chmodB) chownC) umaskD) chgrpAnswer: A24. Which command is used to search for apattern in a file in Linux?A) find
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B) searchC) grepD) scanAnswer: C25. Which command is used to display all filesincluding hidden files in Linux?A) ls -aB) ls -lC) ls -RD) ls -aRAnswer: A26. What is the default shell in most Linuxdistributions?A) bashB) dashC) zshD) fishAnswer: A27. Which of the following is NOT amultitasking operating system?A) WindowsB) LinuxC) DOSD) macOSAnswer: C28. Which command is used to display theoperating system name in Linux?A) osB) unixC) kernelD) unameAnswer: D29. Which command is used to get help abouta command in Linux?A) helpB) manC) infoD) Both B and CAnswer: D30. Which command is used to display the fileinode number in Linux?A) ls -lB) ls -oC) ls -aD) ls -iAnswer: D31. Which command is used to create a newdirectory in Linux?

A) newdirB) mkdirC) makedirD) createdirAnswer: B32. Which command is used to remove anempty directory in Linux?A) rmdirB) deldirC) removedirD) rmAnswer: A33. Which command is used to display detailedinformation about files in Linux?A) ls -lB) ls -aC) ls -lhD) ls -ldAnswer: A34. Which command is used to display the Unixversion?A) uname -rB) uname -nC) uname -tD) kernelAnswer: A35. Which command is used to display all filesincluding hidden files and subdirectories inLinux?A) ls -aB) ls -RC) ls -aRD) ls -lAnswer: C36. Which command is used to extract acolumn from a text file in Linux?A) pasteB) getC) cutD) tarAnswer: C37. Which command is used to display diskconsumption of a directory in Linux?A) duB) dsC) ddD) ddsAnswer: A
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38. Which command is used to change theworking directory in Linux?A) cdB) pwdC) lsD) mvAnswer: A39. Which Windows OS introduced the StartMenu?A) Windows 95B) Windows 98C) Windows XPD) Windows 7Answer: A40. Which of the following is NOT a fileextension in Windows?A) .docxB) .exeC) .jpgD) .binxAnswer: D41. Which command is used to rename a file inLinux?A) renB) mvC) rnD) nameAnswer: B42. Which command is used to display the firstfew lines of a file in Linux?A) headB) tailC) startD) topAnswer: A43. Which command is used to display the lastfew lines of a file in Linux?A) headB) tailC) endD) lastAnswer: B44. Which command is used to compare twofiles in Linux?A) cmpB) diffC) commD) All of the above

Answer: D45. Which command is used to display thecalendar in Linux?A) calB) dateC) timeD) clockAnswer: A46. Which command is used to display the datein Linux?A) calB) dateC) timeD) clockAnswer: B47. Which command is used to shut down thesystem in Linux?A) shutdownB) poweroffC) haltD) All of the aboveAnswer: D48. Which command is used to display therunning processes in Linux?A) psB) topC) htopD) All of the aboveAnswer: D49. Which command is used to search files inLinux?A) findB) searchC) grepD) locateAnswer: A50. Which command is used to display manualpages in Linux?A) helpB) manC) infoD) Both B and CAnswer: D51. Which command is used to display thehostname in Linux?A) hostB) hostnameC) uname -n
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D) Both B and CAnswer: D52. Which command is used to clear theterminal screen in Linux?A) clearB) clsC) cleanD) resetAnswer: A53. Which of the following is NOT a Linuxdirectory?A) /homeB) /binC) /usrD) /winAnswer: D54. Which command is used to display thecurrently logged-in users in Linux?A) whoB) usersC) wD) All of the aboveAnswer: D55. Which command is used to display theamount of free disk space in Linux?A) dfB) duC) freeD) lsAnswer: A56. Which command is used to display memoryusage in Linux?A) free

B) memC) memoryD) usageAnswer: A57. In Windows, which file extension is usedfor executable files?A) .exeB) .txtC) .docD) .mp3Answer: A58. Which of the following is NOT a valid Linuxcommand?A) lsB) cpC) dirD) copyAnswer: D59. Which command is used to display thesystem date and time in Windows CommandPrompt?A) dateB) timeC) Both A and BD) clockAnswer: C60. Which of the following is NOT a function ofan operating system?A) File managementB) Memory managementC) Application developmentD) Device managementAnswer: C
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Topic 3: Programming: Basics of C, C++, Python, Java (Syntax, Logic,
Flowcharts, Algorithms)

1. Who is the creator of the C
language?
A) Bjarne Stroustrup
B) Dennis Ritchie
C) James Gosling
D) Guido van Rossum
Answer: B
2. Which of the following is the correct
file extension for C++ source files?
A) .c
B) .cpp
C) .py
D) .java
Answer: B
3. Who developed Python?
A) Dennis Ritchie
B) Bjarne Stroustrup
C) Guido van Rossum
D) James Gosling
Answer: C

4. Which language is known as
platform-independent?
A) C
B) C++
C) Java
D) Python
Answer: C
5. What is the output of print(2 + 3 * 4)
in Python?
A) 20
B) 14
C) 24
D) 9
Answer: B
6. Which symbol is used to end a
statement in C?
A) ,
B) .
C) ;
D) :
Answer: C
7. Which of the following is not a valid
variable name in C++?
A) myVar
B) _var
C) 2ndVar
D) var_2
Answer: C
8. Which of the following is used for
single-line comments in Java?
A) //
B) /*
C) #
D) <!--
Answer: A
9. Which function is used to display
output in C?
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A) cout
B) print
C) printf
D) echo
Answer: C
10. What is the correct way to declare
a variable in Python?
A) int x = 5;
B) x = 5
C) int x; x = 5;
D) declare x = 5
Answer: B
11. Which of the following is not a
primitive data type in Java?
A) int
B) float
C) string
D) double
Answer: C
12. What is the output of cout <<
"Hello"; in C++?
A) Hello
B) "Hello"
C) cout << Hello
D) Error
Answer: A
13. Which function reads a line of text
in Python?
A) scanf()
B) gets()
C) input()
D) read()
Answer: C
14. In C, which header file is required
for printf()?
A) stdio.h
B) conio.h
C) iostream
D) string.h
Answer: A

15. Which of the following is an object-
oriented language?
A) C
B) C++
C) Python
D) Both B and C
Answer: D
16. Which of the following is not a loop
structure?
A) for
B) while
C) repeat
D) do-while
Answer: C
17. What is the output of
System.out.println(5/2); in Java?
A) 2.5
B) 2
C) 2.0
D) Error
Answer: B
18. What is the correct syntax to start a
main function in C++?
A) void main()
B) public static void main()
C) int main()
D) main()
Answer: C
19. Which of the following is used to
define a block of code in Python?
A) {}
B) []
C) Indentation
D) ()
Answer: C
20. Which keyword is used to inherit a
class in Java?
A) extends
B) implements
C) inherit
D) inherits
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Answer: A
21. What is the correct way to write a
multi-line comment in C?
A) // comment //
B) /* comment */
C) # comment #
D) <!-- comment -->
Answer: B
22. Which of the following is used for
input in C++?
A) cin
B) scanf
C) input
D) gets
Answer: A
23. Which function is used to find the
length of a string in Python?
A) strlen()
B) length()
C) len()
D) size()
Answer: C
24. What is the output of print(10 // 3)
in Python?
A) 3.33
B) 3
C) 3.0
D) 4
Answer: B
25. Which keyword is used to define a
function in Python?
A) func
B) function
C) def
D) define
Answer: C
26. Which operator is used for logical
AND in C++?
A) &&
B) and
C) &

D) AND
Answer: A
27. Which of the following is a valid
identifier in Java?
A) 1name
B) name_1
C) name-1
D) name 1
Answer: B
28. Which of the following is not a
valid data type in C?
A) float
B) double
C) real
D) int
Answer: C
29. What is the output of
System.out.println("2" + 3 + 4); in
Java?
A) 234
B) 9
C) 7
D) Error
Answer: A
30. Which symbol is used for single-line
comments in Python?
A) //
B) #
C) --
D) ;;
Answer: B
31. Which of the following is used to
terminate a loop in C?
A) stop
B) exit
C) break
D) end
Answer: C
32. Which function is used to read
formatted input in C?
A) gets()
B) scanf()
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C) input()
D) cin
Answer: B
33. Which of the following is a correct
way to declare an array in C++?
A) int arr;
B) array arr;
C) int arr();
D) arr int;
Answer: A
34. Which of the following is not a
valid loop in Java?
A) for
B) while
C) do-while
D) repeat-until
Answer: D
35. Which of the following is not a
feature of Python?
A) Dynamically typed
B) Interpreted
C) Case-insensitive
D) Indentation-based
Answer: C
36. What is the output of printf("%d",
5 == 5); in C?
A) true
B) 1
C) false
D) 0
Answer: B
37. Which of the following is the
correct way to declare a class in C++?
A) class A {};
B) class A[];
C) class A();
D) class A;
Answer: A
38. Which method is the entry point of
a Java program?
A) start()
B) main()

C) run()
D) execute()
Answer: B
39. Which of the following is the
correct way to write a function in
Python?
A) function add():
B) def add():
C) func add():
D) define add():
Answer: B
40. Which keyword is used to create an
object in Java?
A) new
B) create
C) object
D) make
Answer: A
41. Which operator is used for
exponentiation in Python?
A) ^
B) **
C) pow
D) exp
Answer: B
42. Which of the following is not a
valid access modifier in Java?
A) public
B) private
C) protected
D) void
Answer: D
43. Which of the following is used to
define a constant in C?
A) const
B) define
C) #define
D) Both A and C
Answer: D
44. Which of the following is not a
valid data type in Python?
A) int
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B) float
C) char
D) str
Answer: C
45. Which of the following is used to
represent decision in a flowchart?
A) Rectangle
B) Diamond
C) Oval
D) Parallelogram
Answer: B
46. Which of the following is not a
keyword in C++?
A) friend
B) this
C) then
D) virtual
Answer: C
47. Which of the following is used for
string concatenation in Java?
A) +
B) &
C) .
D) concat
Answer: A
48. Which function is used to convert a
string to integer in Python?
A) int()
B) str()
C) float()
D) chr()
Answer: A
49. Which of the following is the
correct syntax for a for loop in C?
A) for(i=0; i<5; i++)
B) for i = 0 to 5
C) for(i=0, i<5, i++)
D) for i in range(5)
Answer: A
50. Which of the following is used to
exit a program in Java?
A) exit()

B) quit()
C) System.exit(0)
D) stop()
Answer: C
51. What is the output of print(type(5))
in Python?
A) int
B) <class PintP>
C) integer
D) type
Answer: B
52. Which of the following is not a
valid operator in C?
A) +
B) -
C) **
D) /
Answer: C
53. Which of the following is used to
declare a pointer in C++?
A) int p;
B) int p;
C) int &p;
D) pointer p;
Answer: A
54. Which of the following is used to
import a package in Java?
A) include
B) import
C) using
D) package
Answer: B
55. Which of the following is not a
feature of C++?
A) Object-oriented
B) Platform-independent
C) Operator overloading
D) Function overloading
Answer: B
56. Which function is used to read a
character from the user in C?
A) getchar()
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B) getch()
C) input()
D) read()
Answer: A
57. Which of the following is used to
indicate the end of a block in Python?
A) }
B) end
C) Indentation
D) ;
Answer: C
58. Which of the following is not a
valid way to declare a variable in Java?
A) int x = 5;
B) float y = 2.5;
C) string s = "hello";
D) double z;
Answer: C
59. Which of the following is used to
define a macro in C?
A) #define
B) define
C) macro
D) #macro
Answer: A
60. Which of the following is used to
represent input/output in a flowchart?
A) Rectangle
B) Diamond
C) Parallelogram
D) Circle
Answer: C
61. Which of the following is used to
check equality in Python?
A) =
B) ==
C) :=
D) equals
Answer: B
62. Which of the following is not a
valid escape sequence in C?
A) \n

B) \t
C) \b
D) \p
Answer: D
63. Which of the following is used to
define a class in Java?
A) class
B) Class
C) object
D) struct
Answer: A
64. Which of the following is not a
valid function name in C?
A) main
B) 1main
C) _main
D) main1
Answer: B
65. Which of the following is used to
access members of a class in C++?
A) .
B) ->
C) ::
D) Both A and B
Answer: D
66. Which of the following is not a
valid logical operator in Java?
A) &&
B) ||
C) !
D) <>
Answer: D
67. Which of the following is used to
define a function in C?
A) function
B) def
C) void
D) func
Answer: C
68. Which of the following is not a
valid data type in Java?
A) int
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B) float
C) real
D) double
Answer: C
69. Which of the following is used to
create a list in Python?
A) ()
B) []
C) {}
D) <>
Answer: B
70. Which of the following is used to
represent the start/end in a flowchart?

A) Rectangle
B) Diamond
C) Oval
D) Parallelogram

Answer: C

MCQ Topic 4: Data Structures: Arrays, stacks, queues,
linked lists, trees, graphs, searching & sorting.

1. Which data structure allows random accessto elements using an index?A) Array

B) StackC) QueueD) Linked ListAnswer: A
2. What is the time complexity for accessing anelement in an array by index?A) O(1)B) O(n)C) O(log n)D) O(n^2)Answer: A3. Which data structure follows Last-In, First-Out (LIFO) principle?A) QueueB) StackC) Linked ListD) TreeAnswer: B
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4. Which operation removes the top elementfrom a stack?A) PushB) PopC) EnqueueD) DequeueAnswer: B5. What is the time complexity of searching foran element in an unsorted array?A) O(1)B) O(n)C) O(log n)D) O(n log n)Answer: B6. Which data structure is used to implementrecursion?A) StackB) QueueC) ArrayD) TreeAnswer: A7. Which data structure follows First-In, First-Out (FIFO) principle?A) StackB) QueueC) Linked ListD) TreeAnswer: B8. In a queue, insertion is performed at the______ and deletion at the ______.A) front, rearB) rear, frontC) middle, endD) end, startAnswer: B9. Which data structure is best suited forimplementing a browser’s back button?A) QueueB) StackC) ArrayD) TreeAnswer: B10. What is the reference of the last node in asingly linked list?A) First nodeB) Middle nodeC) NULLD) Random node

Answer: C11. Which data structure represents ahierarchical relationship?A) StackB) QueueC) Linked ListD) TreeAnswer: D12. What is the maximum number of children anode can have in a binary tree?A) 1B) 2C) 3D) UnlimitedAnswer: B13. Which traversal is used for Breadth FirstSearch (BFS) in graphs?A) StackB) QueueC) ArrayD) TreeAnswer: B14. Which data structure is used for Depth FirstSearch (DFS) in graphs?A) StackB) QueueC) ArrayD) Linked ListAnswer: A15. Which of the following is a non-linear datastructure?A) ArrayB) StackC) TreeD) QueueAnswer: C16. Which data structure uses pointers forsequential access?A) StackB) QueueC) Linked ListD) TreeAnswer: C17. What is a circular linked list?A) Last node points to first nodeB) First node points to last nodeC) Each node points to itselfD) No pointers
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Answer: A18. What is the disadvantage of arrays?A) Fixed sizeB) Slow accessC) Dynamic memoryD) No indexAnswer: A19. Which data structure allows insertion anddeletion at both ends?A) StackB) QueueC) DequeD) ArrayAnswer: C20. What is a doubly linked list?A) Each node points to next nodeB) Each node points to previous nodeC) Each node points to both next and previousnodesD) Each node points to rootAnswer: C21. Which data structure is best forimplementing a priority queue?A) StackB) QueueC) HeapD) ArrayAnswer: C22. What is the time complexity of searching ina binary search tree (BST) in best case?A) O(1)B) O(log n)C) O(n)D) O(n^2)Answer: B23. Which sorting algorithm repeatedly swapsadjacent elements if they are in the wrongorder?A) Selection sortB) Bubble sortC) Merge sortD) Quick sortAnswer: B24. Which sorting algorithm divides the arrayinto halves and merges them in sorted order?A) Selection sortB) Bubble sortC) Merge sort

D) Insertion sortAnswer: C25. What is the time complexity of quick sort inaverage case?A) O(n)B) O(n^2)C) O(n log n)D) O(log n)Answer: C26. Which data structure is used forimplementing function calls in programminglanguages?A) QueueB) StackC) ArrayD) HeapAnswer: B27. Which operation adds an element to therear of a queue?A) PushB) EnqueueC) PopD) DequeueAnswer: B28. What is the condition for an empty queuein linked list implementation?A) Front = RearB) Front = NULLC) Rear = NULLD) Both B and CAnswer: D
29. Which data structure is used for undooperation in text editors?A) StackB) QueueC) ArrayD) TreeAnswer: A30. Which data structure is used for call centertask scheduling?A) StackB) QueueC) Linked ListD) TreeAnswer: B31. What is the time complexity of linearsearch?
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A) O(1)B) O(log n)C) O(n)D) O(n^2)Answer: C32. Which of the following is NOT a linear datastructure?A) ArrayB) Linked ListC) StackD) GraphAnswer: D33. Which data structure is used to check forbalanced parenthesis in an expression?A) QueueB) StackC) ArrayD) TreeAnswer: B34. What is the time complexity of accessingan element in a linked list?A) O(1)B) O(log n)C) O(n)D) O(n^2)Answer: C35. Which data structure is used forimplementing BFS in a graph?A) StackB) QueueC) ArrayD) TreeAnswer: B36. Which of the following is an application ofstack?A) Tower of HanoiB) Infix to postfix conversionC) Function call managementD) All of the aboveAnswer: D37. Which of the following is a self-referentialstructure?A) ArrayB) StackC) Linked ListD) QueueAnswer: C

38. Which data structure is used forimplementing undo and redo features?A) StackB) QueueC) ArrayD) TreeAnswer: A39. Which data structure is used for level ordertraversal of a tree?A) StackB) QueueC) ArrayD) Linked ListAnswer: B40. What is the maximum number of nodes atlevel ‘l’ in a binary tree?A) 2^lB) lC) l^2D) 2*lAnswer: A41. Which data structure is best forimplementing adjacency lists in graphs?A) ArrayB) Linked ListC) StackD) QueueAnswer: B42. What is the disadvantage of a circularlinked list?A) Infinite loop possibilityB) Last node points to first nodeC) Time consumingD) More memoryAnswer: A43. Which of the following is a non-linear datastructure?A) StackB) QueueC) GraphD) ArrayAnswer: C44. Which operation is performed to add anelement at the top of a stack?A) PushB) PopC) EnqueueD) Dequeue
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Answer: A45. What is the time complexity of insertion ina stack?A) O(1)B) O(log n)C) O(n)D) O(n^2)Answer: A46. Which data structure is used forimplementing a circular queue?A) ArrayB) Linked ListC) StackD) Both A and BAnswer: D47. Which of the following is true about stacksand queues?A) Stack: LIFO, Queue: FIFOB) Stack: FIFO, Queue: LIFOC) Both are LIFOD) Both are FIFOAnswer: A48. What is the time complexity of searching ina balanced binary search tree?A) O(1)B) O(log n)C) O(n)D) O(n^2)Answer: B49. Which of the following is an application ofqueues?A) CPU schedulingB) Printer task schedulingC) Call center systemsD) All of the aboveAnswer: D50. Which sorting algorithm is best for smalldatasets?A) Bubble sortB) Insertion sortC) Merge sortD) Quick sortAnswer: B51. Which data structure is used forimplementing a hash table?A) StackB) QueueC) Array

D) Linked ListAnswer: C52. What is the worst-case time complexity ofbinary search?A) O(1)B) O(log n)C) O(n)D) O(n log n)Answer: B53. Which data structure is used to represent asparse matrix efficiently?A) ArrayB) Linked ListC) StackD) QueueAnswer: B54. Which traversal is used for evaluatingarithmetic expressions in a tree?A) InorderB) PreorderC) PostorderD) Level orderAnswer: C55. Which of the following is NOT a type oftree?A) Binary treeB) AVL treeC) Red-Black treeD) Circular treeAnswer: D56. Which data structure is used forimplementing undo operation in text editors?A) StackB) QueueC) ArrayD) TreeAnswer: A57. What is the time complexity of deletion ina queue?A) O(1)B) O(log n)C) O(n)D) O(n^2)Answer: A58. Which of the following is a disadvantage ofarrays?A) Fixed sizeB) Wastage of memory
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C) Insertion/deletion is costlyD) All of the aboveAnswer: D59. Which data structure is used forimplementing BFS in a graph?A) StackB) QueueC) ArrayD) TreeAnswer: B60. Which sorting algorithm has the bestaverage case performance?A) Bubble sortB) Selection sortC) Quick sortD) Insertion sortAnswer: C61. Which data structure is used forpolynomial representation?A) ArrayB) Linked ListC) StackD) QueueAnswer: B62. What is the time complexity of insertion ina linked list?A) O(1)B) O(n)C) O(log n)D) O(n^2)Answer: A63. Which of the following is NOT a linear datastructure?A) ArrayB) StackC) TreeD) QueueAnswer: C64. Which data structure is used for functioncall management?A) StackB) QueueC) ArrayD) Tree

Answer: A65. Which of the following is used forimplementing adjacency matrix in graphs?A) ArrayB) Linked ListC) StackD) QueueAnswer: A66. Which data structure is used forimplementing undo and redo features?A) StackB) QueueC) ArrayD) TreeAnswer: A67. Which of the following is true about binarytrees?A) Each node has at most two childrenB) Each node has at most one childC) Each node has at most three childrenD) Each node has unlimited childrenAnswer: A68. What is the time complexity of searching ina hash table (average case)?A) O(1)B) O(log n)C) O(n)D) O(n^2)Answer: A69. Which data structure is used forimplementing a circular queue?A) ArrayB) Linked ListC) StackD) Both A and BAnswer: D70. Which data structure is used forimplementing infix to postfix conversion?A) StackB) QueueC) ArrayD) TreeAnswer: A
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MCQ Topic 5: Database Management: DBMS concepts, SQL
basics, ER diagrams, normalization.

1. What is the full form of DBMS?
A) Data Binary Management System
B) Database Management System
C) Database Management Service
D) Data Backup Management System
Answer: B
2. What is database?
A) Organized collection of data
B) Collection of program
C) Type of software
D) Type of computer
Answer: A
3. Which of the following is NOT a
function of DBMS?
A) Data storage
B) Data manipulation
C) Data security
D) Software installation
Answer: D

4. Which of the following is a
component of DBMS?
A) Data
B) Data Manager
C) Data Languages
D) All of the above
Answer: D
5. Who created the first DBMS?
A) Edgar F. Codd
B) Charles Bachman
C) Charles Babbage
D) Sharon B. Codd
Answer: B
6. Which type of data can be stored in
a database?
A) Text
B) Images
C) Audio/Video
D) All of the above
Answer: D
7. Which of the following is not a type
of database?
A) Hierarchical
B) Network
C) Distributed
D) Decentralized
Answer: D
8. The overall design of the database is
called:
A) Instance
B) Schema
C) Table
D) Tuple
Answer: B
9. The collection of information stored
at a particular moment is called:
A) Schema
B) Instance
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C) Table
D) Attribute
Answer: B
10. Which of the following is a feature
of DBMS?
A) Data redundancy
B) Data inconsistency
C) Data security
D) Data isolation
Answer: C
SQL Basics
11. Which command is used to create a
new table in SQL?
A) INSERT
B) CREATE TABLE
C) UPDATE
D) ALTER
Answer: B
12. Which command is used to remove
all records from a table, including all
spaces allocated?
A) DELETE
B) REMOVE
C) DROP
D) TRUNCATE
Answer: D
13. Which SQL statement is used to
extract data from a database?
A) GET
B) SELECT
C) EXTRACT
D) OPEN
Answer: B
14. Which SQL clause is used to filter
the results of a query?
A) ORDER BY
B) WHERE
C) GROUP BY
D) HAVING

Answer: B
15. Which command is used to add a
new record in a table?
A) ADD
B) INSERT INTO
C) NEW
D) APPEND
Answer: B
16. Which command is used to change
data in a table?
A) INSERT
B) UPDATE
C) SELECT
D) DELETE
Answer: B
17. Which SQL keyword is used to sort
the result-set?
A) ORDER BY
B) SORT BY
C) GROUP BY
D) ARRANGE BY
Answer: A
18. Which command is used to remove
a table from the database?
A) DELETE
B) REMOVE
C) DROP
D) ERASE
Answer: C
19. Which SQL statement is used to
modify the structure of an existing
table?
A) ALTER TABLE
B) MODIFY TABLE
C) CHANGE TABLE
D) UPDATE TABLE
Answer: A
20. Which SQL function is used to
count the number of rows in a table?
A) TOTAL()
B) COUNT()
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C) SUM()
D) NUMBER()
Answer: B
ER Diagrams
21. In an ER diagram, rectangles
represent:
A) Entities
B) Attributes
C) Relationships
D) Keys
Answer: A
22. In an ER diagram, ellipses
represent:
A) Entities
B) Attributes
C) Relationships
D) Keys
Answer: B
23. In an ER diagram, diamonds
represent:
A) Entities
B) Attributes
C) Relationships
D) Keys
Answer: C
24. The line connecting an entity to an
attribute in an ER diagram represents:
A) Relationship
B) Ownership
C) Association
D) Mapping
Answer: C
25. A weak entity is:
A) An entity with no attributes
B) An entity that cannot be uniquely
identified by its attributes alone
C) An entity with only one attribute
D) A temporary entity
Answer: B

26. Which of the following is a one-to-
many relationship?
A) A student has one roll number
B) A department has many employees
C) A country has one capital
D) A book has one title
Answer: B
27. In an ER diagram, a double
rectangle represents:
A) Strong entity
B) Weak entity
C) Attribute
D) Relationship
Answer: B
28. Which symbol is used for multi-
valued attributes in ER diagrams?
A) Double ellipse
B) Rectangle
C) Diamond
D) Double rectangle
Answer: A
29. Which of the following is not a type
of attribute in ER diagrams?
A) Simple
B) Composite
C) Derived
D) Sequential
Answer: D
30. The process of designing the
structure of a database is called:
A) Normalization
B) Data Modeling
C) Data Mining
D) Data Warehousing
Answer: B
Normalization
31. What is the main purpose of
normalization?
A) To increase redundancy
B) To reduce redundancy
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C) To increase data inconsistency
D) To reduce security
Answer: B
32. 1NF (First Normal Form) requires:
A) No duplicate rows
B) No repeating groups
C) No composite attributes
D) All of the above
Answer: D
33. A table is in 2NF if:
A) It is in 1NF and every non-prime
attribute is fully functionally dependent
on the primary key
B) It is in 1NF and has no partial
dependency
C) Both A and B
D) None of the above
Answer: C
34. 3NF (Third Normal Form) removes:
A) Partial dependency
B) Transitive dependency
C) Multi-valued dependency
D) Functional dependency
Answer: B
35. Which normal form removes
transitive dependency?
A) 1NF
B) 2NF
C) 3NF
D) BCNF
Answer: C
36. Which of the following is a
violation of 1NF?
A) Atomic values
B) Non-atomic values
C) Unique keys
D) Foreign keys
Answer: B
37. A table with a single candidate key
is always in:
A) 1NF
B) 2NF

C) 3NF
D) BCNF
Answer: D
38. Which normal form is based on the
concept of functional dependency?
A) 1NF
B) 2NF
C) 3NF
D) All of the above
Answer: D
39. Which of the following is not a
normal form?
A) 1NF
B) 2NF
C) 4NF
D) 5NF
Answer: None (All are normal forms)
40. Which normal form deals with
multi-valued dependencies?
A) 1NF
B) 2NF
C) 3NF
D) 4NF
Answer: D
41. Keys and Constraints
A primary key:
A) Can be NULL
B) Must be unique
C) Can have duplicate values
D) Is not necessary
Answer: B
42. A foreign key is used to:
A) Uniquely identify a record
B) Link two tables
C) Sort data
D) Encrypt data
Answer: B
43. A candidate key is:
A) A key that can uniquely identify a
row
B) Always the primary key
C) Never used
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D) Used for sorting
Answer: A
44. A composite key is:
A) A key with only one attribute
B) A key with multiple attributes
C) A key with no attributes
D) A key with foreign attributes
Answer: B
45. Which constraint ensures that a
column cannot have NULL values?
A) UNIQUE
B) PRIMARY KEY
C) NOT NULL
D) CHECK
Answer: C
46. Which constraint is used to ensure
all values in a column are different?
A) PRIMARY KEY
B) UNIQUE
C) NOT NULL
D) FOREIGN KEY
Answer: B
47. Which constraint is used to enforce
a condition on a column?
A) CHECK
B) DEFAULT
C) NOT NULL
D) UNIQUE
Answer: A
48. Which key is used to uniquely
identify each record in a table?
A) Foreign key
B) Candidate key
C) Primary key
D) Alternate key
Answer: C
49. Which key is not selected as
primary key but can be used as one?
A) Composite key
B) Alternate key
C) Super key
D) Foreign key

Answer: B
50. Which of the following is a set of
one or more attributes that uniquely
identifies a record?
A) Primary key
B) Candidate key
C) Super key
D) All of the above
Answer: D
51. SQL Queries and Functions
Which SQL function returns the largest
value in a column?
A) MAX()
B) MIN()
C) AVG()
D) COUNT()
Answer: A
52. Which SQL function returns the
average value of a numeric column?
A) SUM()
B) AVG()
C) MEAN()
D) COUNT()
Answer: B
53. Which SQL function returns the
number of rows?
A) COUNT()
B) SUM()
C) TOTAL()
D) NUMBER()
Answer: A
54. Which SQL clause is used to group
rows that have the same values?
A) GROUP BY
B) ORDER BY
C) HAVING
D) WHERE
Answer: A
55. Which SQL clause is used to filter
groups?
A) WHERE
B) GROUP BY
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C) HAVING
D) ORDER BY
Answer: C
56. Which SQL statement is used to
delete a table?
A) DELETE
B) DROP
C) REMOVE
D) ERASE
Answer: B
57. Which SQL statement is used to
add a new column to a table?
A) ALTER TABLE
B) ADD COLUMN
C) MODIFY TABLE
D) UPDATE TABLE
Answer: A
58. Which SQL command is used to
change the value of a column in a
table?
A) ALTER
B) UPDATE
C) MODIFY
D) CHANGE
Answer: B
59. Which SQL function returns the
smallest value in a column?
A) MIN()
B) MAX()
C) AVG()
D) COUNT()
Answer: A
60. Which SQL keyword is used to
eliminate duplicate rows?
A) DISTINCT
B) UNIQUE
C) ONLY
D) FIRST
Answer: A
Advanced DBMS Concepts

61. What does ACID stand for?
A) Atomicity, Consistency, Isolation,
Durability
B) Accuracy, Consistency, Integrity,
Durability
C) Atomicity, Concurrency, Isolation,
Durability
D) Accuracy, Concurrency, Isolation,
Durability
Answer: A
62. Which property ensures that a
transaction is all-or-nothing?
A) Consistency
B) Atomicity
C) Isolation
D) Durability
Answer: B
63. Which property ensures that a
transaction does not affect other
transactions?
A) Consistency
B) Atomicity
C) Isolation
D) Durability
Answer: C
64. Which property ensures that once a
transaction is committed, it remains
so?
A) Consistency
B) Atomicity
C) Isolation
D) Durability
Answer: D
65. Which property ensures that
database remains in a valid state
before and after a transaction?
A) Consistency
B) Atomicity
C) Isolation
D) Durability
Answer: A
66. What is a transaction?



89 | P a g e

A) A single SQL command
B) A set of logically related operations
C) A table
D) A database
Answer: B
67. Which SQL command is used to
save all changes made during the
current transaction?
A) SAVE
B) COMMIT
C) ROLLBACK
D) END
Answer: B
68. Which SQL command is used to
undo changes since the last commit?
A) SAVE
B) COMMIT
C) ROLLBACK
D) END
Answer: C
69. Which of the following is NOT a
type of DBMS model?
A) Hierarchical
B) Network
C) Relational
D) Sequential
Answer: D
70. Which of the following is a
relational database management
system?
A) MySQL
B) Oracle
C) SQL Server
D) All of the above
Answer: D
71. ER Modeling and Relationships
An entity set that does not have
sufficient attributes to form a primary
key is a:
A) Strong entity set
B) Weak entity set
C) Simple entity set

D) Primary entity set
Answer: B
72. A relationship in which one entity is
associated with many entities of
another type is:
A) One-to-one
B) One-to-many
C) Many-to-one
D) Many-to-many
Answer: B
73. A derived attribute is represented
in ER diagrams by:
A) Dashed ellipse
B) Double ellipse
C) Rectangle
D) Diamond
Answer: A
74. A composite attribute is:
A) An attribute with more than one
value
B) An attribute that can be divided into
smaller sub-parts
C) An attribute with only one value
D) None of the above
Answer: B
75. Which of the following is not a
valid relationship type in ER diagrams?
A) One-to-one
B) One-to-many
C) Many-to-one
D) None-to-many
Answer: D
76. The process of mapping ER
diagrams to tables is called:
A) Normalization
B) Schema mapping
C) Data mining
D) Data warehousing
Answer: B
77. The total number of entity sets that
participate in a relationship is called:
A) Degree



90 | P a g e

B) Cardinality
C) Participation
D) Connectivity
Answer: A
78. The number of times an entity set
participates in a relationship is called:
A) Degree
B) Cardinality
C) Participation
D) Connectivity
Answer: B
79. Which of the following is not a
valid attribute type?
A) Simple
B) Composite
C) Derived
D) Sequential
Answer: D
80. Which of the following is a ternary
relationship?
A) Involves two entities
B) Involves three entities
C) Involves four entities
D) Involves one entity
Answer: B
81. Normalization and Decomposition
Which of the following is not a step in
normalization?
A) Removing repeating groups
B) Removing partial dependency
C) Removing transitive dependency
D) Adding redundancy
Answer: D
82. Which normal form is concerned
with removing partial dependency?
A) 1NF
B) 2NF
C) 3NF
D) 4NF
Answer: B

83. Which normal form is concerned
with removing multi-valued
dependency?
A) 2NF
B) 3NF
C) 4NF
D) 5NF
Answer: C
84. A table with transitive dependency
is not in:
A) 1NF
B) 2NF
C) 3NF
D) 4NF
Answer: C
85. Which of the following is a benefit
of normalization?
A) Data redundancy
B) Data inconsistency
C) Data integrity
D) Data isolation
Answer: C
86. Which of the following is a lossless
decomposition?
A) No loss of data
B) Loss of data
C) Loss of information
D) Loss of attributes
Answer: A
87. Which of the following is a
dependency preservation property?
A) All functional dependencies are
preserved
B) Some dependencies are lost
C) No dependencies are preserved
D) None of the above
Answer: A
88. Which of the following is not a type
of dependency?
A) Functional
B) Partial
C) Transitive
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D) Sequential
Answer: D
89. Which of the following is not a
reason for denormalization?
A) Improve performance
B) Reduce complexity
C) Increase redundancy
D) Increase inconsistency
Answer: D
90. Which of the following is used to
uniquely identify a row in a table?
A) Foreign key
B) Primary key
C) Alternate key
D) Candidate key
Answer: B
Miscellaneous
91. Which of the following is not a DDL
command?
A) CREATE
B) DROP
C) ALTER
D) SELECT
Answer: D
92. Which of the following is not a DML
command?
A) SELECT
B) INSERT
C) DELETE
D) DROP
Answer: D
93. Which of the following is a DCL
command?
A) GRANT
B) SELECT
C) UPDATE
D) INSERT
Answer: A
94. Which of the following is not a TCL
command?

A) COMMIT
B) ROLLBACK
C) SAVEPOINT
D) DELETE
Answer: D
95. Which of the following is not a
valid SQL data type?
A) INT
B) VARCHAR
C) FLOAT
D) NUMBERIC
Answer: D
96. Which command is used to remove
a record from a table?
A) DELETE
B) REMOVE
C) DROP
D) ERASE
Answer: A
97. Which of the following is a
command to retrieve data from a
database?
A) SELECT
B) GET
C) EXTRACT
D) FIND
Answer: A
98. Which of the following is not a
valid aggregate function in SQL?
A) SUM()
B) COUNT()
C) AVG()
D) NUMBER()
Answer: D
99. Which of the following is not a
valid SQL clause?
A) WHERE
B) HAVING
C) ORDER BY
D) BETWEEN BY
Answer: D
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100. Which of the following is not a
valid SQL keyword?
A) SELECT
B) FROM
C) WHERE
D) PRINT
Answer: D

MCQ Topic 6: Networking: OSI model, TCP/IP, LAN/WAN,
Internet basics, network devices, security.

OSI Model & TCP/IP
1. How many layers are there in the OSImodel?A) 4B) 5C) 6D) 7Answer: D2. The OSI model was developed by:A) ISOB) IEEEC) IETF

D) ITUAnswer: A3. Which layer of OSI is responsible for logicaladdressing and routing?A) Data LinkB) NetworkC) TransportD) SessionAnswer: B4. Which layer of OSI model providesencryption and compression?A) ApplicationB) PresentationC) SessionD) Data LinkAnswer: B
5. Which OSI layer is responsible for end-to-end delivery?A) NetworkB) Data LinkC) TransportD) SessionAnswer: C6. Which layer of OSI model is closest to theuser?A) ApplicationB) PresentationC) SessionD) NetworkAnswer: A
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7. The TCP/IP model has how many layers?A) 4B) 5C) 6D) 7Answer: A8. Which layer in TCP/IP model handlesrouting?A) ApplicationB) TransportC) InternetD) Network AccessAnswer: C
9. Which protocol works at the Transport layerof TCP/IP?A) IPB) TCPC) EthernetD) ARPAnswer: B10. The Application layer in TCP/IP combineswhich OSI layers?A) Application, Presentation, SessionB) Network, Transport, Data LinkC) Physical, Data LinkD) NoneAnswer: A
LAN/WAN/MAN/PAN
11. Which is the smallest network?A) LANB) WANC) PAND) MANAnswer: C12. A network covering a city is called:A) LANB) WANC) MAND) PANAnswer: C13. A network covering a country is called:A) LANB) WANC) MAND) PAN

Answer: B14. Which network connects computers withina building?A) LANB) WANC) MAND) PANAnswer: A15. What is the correct order of network size(smallest to largest)?A) PAN, LAN, MAN, WANB) LAN, PAN, MAN, WANC) PAN, MAN, LAN, WAND) LAN, MAN, WAN, PANAnswer: A16. Which network is used within a singleperson’s workspace?A) LANB) WANC) MAND) PANAnswer: D17. The first form of the internet was:A) ARPANETB) IntranetC) ExtranetD) EthernetAnswer: A18. Which network is private and accessibleonly to an organization’s members?A) InternetB) IntranetC) ExtranetD) WANAnswer: B19. Which network allows selected externalusers limited access?A) IntranetB) ExtranetC) InternetD) LANAnswer: B20. Which network is used for globalcommunication?A) IntranetB) ExtranetC) InternetD) PAN
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Answer: C
Internet Basics & Protocols
21. What does HTTP stand for?A) Hyper Text Transfer ProtocolB) High Text Transfer ProtocolC) Hyper Transfer Text ProtocolD) NoneAnswer: A22. Which protocol is used for secure webbrowsing?A) HTTPB) HTTPSC) FTPD) SMTPAnswer: B23. Which protocol is used for emailtransmission?A) FTPB) SMTPC) HTTPD) SNMPAnswer: B24. Which protocol is used for file transfer?A) FTPB) SMTPC) HTTPD) POP3Answer: A25. What is the function of DNS?A) Assign IP addressesB) Resolve domain namesC) Encrypt dataD) Connect LANsAnswer: B26. Which protocol is connectionless?A) TCPB) UDPC) HTTPD) FTPAnswer: B27. Which protocol is used for remote login?A) FTPB) TelnetC) SMTPD) DNSAnswer: B

28. Which protocol is used to retrieve emailsfrom a server?A) SMTPB) POP3C) HTTPD) FTPAnswer: B29. Which protocol is used for networkmanagement?A) SNMPB) SMTPC) HTTPD) FTPAnswer: A30. What is the port number for HTTP?A) 21B) 23C) 25D) 80Answer: D
Network Devices
31. Which device connects multiple computersin a LAN?A) SwitchB) RouterC) ModemD) RepeaterAnswer: A32. Which device connects different networks?A) SwitchB) RouterC) HubD) BridgeAnswer: B33. Which device amplifies signals?A) SwitchB) RouterC) RepeaterD) ModemAnswer: C34. Which device connects two LAN segmentsand filters traffic?A) HubB) BridgeC) RouterD) Switch
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Answer: B35. Which device converts digital signals toanalog?A) SwitchB) RouterC) ModemD) BridgeAnswer: C36. Which device broadcasts data to allconnected devices?A) SwitchB) HubC) RouterD) BridgeAnswer: B37. Which device is used for wirelessconnectivity?A) ModemB) Access PointC) SwitchD) BridgeAnswer: B38. Which device is used to connect networksusing different protocols?A) GatewayB) SwitchC) HubD) RepeaterAnswer: A39. Which device is used to extend the range ofa network?A) RouterB) SwitchC) RepeaterD) GatewayAnswer: C40. Which device is used for load balancing?A) HubB) SwitchC) Load BalancerD) BridgeAnswer: C
OSI Layers & Functions
41. Which layer is responsible for errordetection and correction?A) Physical

B) Data LinkC) NetworkD) SessionAnswer: B42. Which layer is responsible for physicaltransmission of data?A) PhysicalB) Data LinkC) NetworkD) TransportAnswer: A
43. Which layer is responsible for sessionmanagement?A) SessionB) PresentationC) ApplicationD) TransportAnswer: A44. Which layer handles data formatting andencryption?A) PresentationB) ApplicationC) SessionD) NetworkAnswer: A45. Which layer is responsible for flow control?A) TransportB) NetworkC) Data LinkD) PhysicalAnswer: A46. Which layer handles MAC addressing?A) Data LinkB) NetworkC) PhysicalD) ApplicationAnswer: A47. Which layer is responsible for packetswitching?A) NetworkB) Data LinkC) TransportD) SessionAnswer: A48. Which layer is responsible forsegmentation and reassembly?A) Transport
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B) NetworkC) Data LinkD) ApplicationAnswer: A49. Which layer is responsible for routing?A) NetworkB) Data LinkC) TransportD) ApplicationAnswer: A50. Which layer is responsible for portaddressing?A) TransportB) NetworkC) Data LinkD) PhysicalAnswer: A
IP Addressing & Subnetting
51. What is the length of an IPv4 address?A) 16 bitsB) 32 bitsC) 64 bitsD) 128 bitsAnswer: B52. What is the length of an IPv6 address?A) 32 bitsB) 64 bitsC) 128 bitsD) 256 bitsAnswer: C53. Which class of IP address is used formulticasting?A) Class AB) Class BC) Class DD) Class EAnswer: C54. What is the default subnet mask for a ClassC IP address?A) 255.0.0.0B) 255.255.0.0C) 255.255.255.0D) 255.255.255.255Answer: C55. Which of the following is a private IPaddress?

A) 192.168.1.1B) 8.8.8.8C) 172.217.0.0D) 54.23.12.1Answer: A
56. Which protocol is used for dynamic IPaddressing?A) DNSB) DHCPC) FTPD) SMTPAnswer: B57. What is the loopback IP address?A) 127.0.0.1B) 192.168.0.1C) 10.0.0.1D) 255.255.255.255Answer: A
58. Which protocol translates domain namesto IP addresses?A) DHCPB) DNSC) FTPD) SMTPAnswer: B
59. Which of the following is not a valid IPaddress?A) 192.168.1.1B) 256.100.50.25C) 10.0.0.1D) 172.16.0.1Answer: B60. Which protocol is used for error reportingin networks?A) ICMPB) ARPC) TCPD) UDPAnswer: A
Network Topologies & Media
61. Which topology connects each device toevery other device?A) Bus
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B) RingC) MeshD) StarAnswer: C62. Which topology uses a central hub?A) BusB) StarC) RingD) MeshAnswer: B63. Which topology is most commonly used inLANs?A) BusB) StarC) RingD) MeshAnswer: B64. Which cable is most immune toelectromagnetic interference?A) Twisted pairB) CoaxialC) Optical fiberD) NoneAnswer: C65. Which media is used for wirelesscommunication?A) Optical fiberB) MicrowaveC) Coaxial cableD) Twisted pairAnswer: B66. Which access method is used in Ethernet?A) CSMA/CDB) Token passingC) PollingD) FDDIAnswer: A67. Which cable is used for telephone lines?A) CoaxialB) Twisted pairC) Optical fiberD) HDMIAnswer: B68. Which of the following is not a guidedtransmission medium?A) Twisted pairB) Coaxial cableC) Microwave

D) Optical fiberAnswer: C69. Which device is used at the physical layer?A) HubB) SwitchC) RouterD) BridgeAnswer: A70. Which device operates at both Data Linkand Network layers?A) SwitchB) RouterC) HubD) RepeaterAnswer: B
Network Security
71. What is the main function of a firewall?A) Block unauthorized accessB) Amplify signalsC) Assign IP addressesD) Encrypt dataAnswer: A72. Which software is used to detect andremove viruses?A) FirewallB) AntivirusC) RouterD) SwitchAnswer: B73. What is phishing?A) A type of firewallB) A method to steal sensitive dataC) A network protocolD) A type of cableAnswer: B74. Which of the following is not a malware?A) VirusB) WormC) TrojanD) FirewallAnswer: D75. What is encryption?A) Converting data to codeB) Blocking dataC) Deleting dataD) Compressing data
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Answer: A76. Which protocol is used for secure datatransmission?A) HTTPB) HTTPSC) FTPD) TelnetAnswer: B77. What is the full form of VPN?A) Virtual Private NetworkB) Virtual Public NetworkC) Verified Private NetworkD) NoneAnswer: A
78. Which device can prevent DDoS attacks?A) SwitchB) FirewallC) RepeaterD) HubAnswer: B79. What is the purpose of authentication?A) Verifying user identityB) Encrypting dataC) Routing dataD) Assigning IP addressesAnswer: A80. Which of the following is not a securitythreat?A) VirusB) FirewallC) WormD) TrojanAnswer: B
Miscellaneous & PYQs
81. Which of the following is not a networkprotocol?A) TCPB) UDPC) HTTPD) BIOSAnswer: D82. Which of the following is not a valid portnumber?A) 21B) 80

C) 8080D) 99999Answer: D83. Which protocol is used for voice over IP?A) FTPB) SMTPC) VoIPD) SNMPAnswer: C84. Which of the following is not a function ofthe Data Link layer?A) FramingB) Error detectionC) RoutingD) Flow controlAnswer: C85. Which protocol is used for remote desktopconnection?A) RDPB) FTPC) HTTPD) SMTPAnswer: A86. Which device is used to connect to theInternet via telephone lines?A) ModemB) SwitchC) RouterD) BridgeAnswer: A87. Which of the following is not an applicationlayer protocol?A) HTTPB) FTPC) SMTPD) TCPAnswer: D88. Which of the following is used for errordetection at the Data Link layer?A) Parity bitB) CRCC) ChecksumD) All of the aboveAnswer: D89. Which of the following is not a type ofnetwork?A) LANB) WAN
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C) PAND) TANAnswer: D90. Which protocol is used for network timesynchronization?A) NTPB) FTPC) SMTPD) HTTPAnswer: A91. Which protocol is used to assign IPaddresses automatically?A) DNSB) DHCPC) ARPD) ICMPAnswer: B92. Which of the following is a connection-oriented protocol?A) UDPB) TCPC) ICMPD) ARPAnswer: B93. Which of the following is a connectionlessprotocol?A) TCPB) UDPC) FTPD) SMTPAnswer: B94. Which protocol is used for addressresolution?A) ARPB) DHCPC) SMTPD) FTPAnswer: A95. Which of the following is not a switchingtechnique?A) Circuit switchingB) Packet switchingC) Message switchingD) Frequency switchingAnswer: D96. Which protocol is used for secure filetransfer?A) FTP

B) SFTPC) SMTPD) HTTPAnswer: B97. Which protocol is used for web browsing?A) HTTPB) FTPC) SMTPD) SNMPAnswer: A98. Which of the following is not a function ofa router?A) Routing packetsB) Assigning IP addressesC) Filtering trafficD) Connecting networksAnswer: B99. Which layer of OSI model is responsible forestablishing, managing and terminatingsessions?A) SessionB) PresentationC) ApplicationD) NetworkAnswer: A100. Which layer of OSI model is responsiblefor syntax and semantics of information?A) ApplicationB) PresentationC) SessionD) NetworkAnswer: B
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MCQ Topic 7: Web Technologies: HTML, CSS, Basics of
JavaScript, Internet and WWW

HTML (HyperText Markup Language)
1. What does HTML stand for?A) Hyperlinks and Text Markup LanguageB) Home Tool Markup LanguageC) Hyper Text Markup LanguageD) Hyper Tool Markup LanguageAnswer: C2. Which tag is used for the largest heading?A) <h6>B) <heading>C) <h1>D) <head>Answer: C
3. Which tag is used to create a hyperlink inHTML?A) <link>B) <a>C) <href>D) <hyperlink>Answer: B

4. What is the correct HTML for inserting animage?A) <img href="image.jpg">B) <img src="image.jpg">C) <image src="image.jpg">D) <img link="image.jpg">Answer: B5. Which tag is used to create a line break?A) <break>B) <br>C) <lb>D) <line>Answer: B6. The correct HTML tag for a paragraph is:A) <par>B) <p>C) <pg>D) <paragraph>Answer: B7. Which attribute is used in the <img> tag toprovide alternative text?A) altB) titleC) srcD) textAnswer: A8. HTML documents are saved with whichextension?A) .htm or .htmlB) .docC) .txtD) .webAnswer: A9. Which tag is used to create a numbered list?A) <ul>B) <ol>C) <li>D) <dl>Answer: B10. Which tag is used to create a table row?A) <tr>B) <td>
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C) <th>D) <table>Answer: A11. What does the <title> tag do?A) Sets the page headingB) Sets the browser tab titleC) Displays the main contentD) Adds a commentAnswer: B12. Which tag is used to make text bold?A) <b>B) <strong>C) Both A and BD) <bold>Answer: C13. Which tag is used to create a dropdownlist?A) <input>B) <select>C) <dropdown>D) <list>Answer: B14. Which tag is used to insert a horizontalline?A) <hr>B) <line>C) <hline>D) <hl>Answer: A15. HTML comments start with:A) <!--B) //C) #D) /*Answer: A16. Which tag is used for creating anunordered (bulleted) list?A) <ul>B) <ol>C) <li>D) <dl>Answer: A17. Which tag is used for table data (cell)?A) <td>B) <tr>C) <th>D) <table>Answer: A

18. The correct way to make a checkbox inHTML is:A) <input type="checkbox">B) <checkbox>C) <input checkbox>D) <check>Answer: A19. Which tag is used to define emphasizedtext?A) <i>B) <em>C) Both A and BD) <strong>Answer: C20. Which tag is used to define a division orsection?A) <div>B) <section>C) Both A and BD) <part>Answer: C
CSS (Cascading Style Sheets)
21. What does CSS stand for?A) Computer Style SheetsB) Creative Style SheetsC) Cascading Style SheetsD) Colorful Style SheetsAnswer: C22. Which HTML tag is used to link an externalCSS file?A) <css>B) <style>C) <link>D) <script>Answer: C23. Where in an HTML document is the correctplace to refer to an external CSS file?A) At the end of the documentB) In the <body> sectionC) In the <head> sectionD) After <html>Answer: C24. Which property is used to change the textcolor in CSS?A) font-colorB) color
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C) text-colorD) fgcolorAnswer: B25. How do you select an element with id"main" in CSS?A) .mainB) #mainC) mainD) *mainAnswer: B26. How do you select all <p> elements in CSS?A) pB) .pC) #pD) *pAnswer: A27. What is the correct CSS syntax to make all<h1> elements blue?A) h1 {color: blue;}B) h1:color=blue;C) h1 {text-color: blue;}D) h1 = blue;Answer: A
28. Which property is used to change thebackground color?A) bgcolorB) colorC) background-colorD) backgroundAnswer: C29. Which CSS property is used to change thefont of text?A) font-styleB) font-familyC) font-weightD) font-sizeAnswer: B30. Which symbol is used for class selectors inCSS?A) #B) .C) *D) $Answer: B31. How do you add a comment in CSS?A) // commentB) /* comment */

C) <!-- comment -->D) # commentAnswer: B32. Which property is used to set the spacebetween lines?A) line-heightB) spacingC) letter-spacingD) word-spacingAnswer: A33. How do you make text bold in CSS?A) font-style: bold;B) font-weight: bold;C) style: bold;D) text-style: bold;Answer: B34. How do you underline text in CSS?A) text-decoration: underline;B) underline: true;C) font-underline: true;D) decoration: underline;Answer: A35. Which property is used to align text to thecenter?A) align: center;B) text-align: center;C) center: text;D) text: center;Answer: B36. What is the default value of the positionproperty in CSS?A) fixedB) relativeC) staticD) absoluteAnswer: C37. Which property is used to add shadow totext?A) text-shadowB) shadowC) font-shadowD) box-shadowAnswer: A38. Which property is used to add space insidean element’s border?A) marginB) paddingC) border-spacing
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D) spacingAnswer: B39. Which property is used to add spaceoutside an element’s border?A) marginB) paddingC) border-spacingD) spacingAnswer: A40. Which property is used to set the width ofan element?A) widthB) sizeC) element-widthD) set-widthAnswer: A
JavaScript Basics
41. What is JavaScript?A) A programming languageB) A markup languageC) A style sheet languageD) A databaseAnswer: A42. Where is JavaScript code usually placed inan HTML document?A) <head> or <body>B) <footer>C) <title>D) <meta>Answer: A43. How do you write a comment inJavaScript?A) <!-- comment -->B) // commentC) # commentD) /* comment */Answer: B44. Which tag is used to include JavaScript inHTML?A) <js>B) <javascript>C) <script>D) <code>Answer: C45. What is the correct syntax to display "HelloWorld" in an alert box?

A) alertBox("Hello World");B) msg("Hello World");C) alert("Hello World");D) msgBox("Hello World");Answer: C46. Which symbol is used for single-linecomments in JavaScript?A) //B) <!--C) #D) **Answer: A
47. How do you declare a variable inJavaScript?A) var name;B) variable name;C) v name;D) declare name;Answer: A48. Which keyword is used to define a functionin JavaScript?A) functionB) funcC) defineD) methodAnswer: A49. How do you call a function named"myFunction"?A) call myFunction();B) myFunction();C) call.function(myFunction);D) function.myFunction();Answer: B50. What is the correct way to write an array inJavaScript?A) var colors = "red", "green", "blue";B) var colors = (1:"red", 2:"green", 3:"blue");C) var colors = ["red", "green", "blue"];D) var colors = 1 = ("red"), 2 = ("green"), 3 =("blue");Answer: C51. Which event occurs when a user clicks onan HTML element?A) onmouseoverB) onclickC) onchangeD) onmouseclick
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Answer: B52. How do you write "Hello" to the browserconsole?A) print("Hello");B) console.log("Hello");C) document.write("Hello");D) alert("Hello");Answer: B53. Which operator is used to assign a value toa variable?A) =B) ==C) ===D) :=Answer: A54. How do you start a multi-line comment inJavaScript?A) //B) <!--C) /*D) #Answer: C55. What is the correct way to check if x isequal to 5 in JavaScript?A) if x = 5B) if (x == 5)C) if x == 5 thenD) if (x = 5)Answer: B56. Which method is used to get an element byits ID in JavaScript?A) getElementById()B) getElement(id)C) getId()D) getById()Answer: A57. How do you create a function in JavaScript?A) function myFunction() {}B) create myFunction() {}C) function:myFunction() {}D) def myFunction() {}Answer: A58. Which of the following is a valid variablename in JavaScript?A) 1nameB) name1C) name-1D) name 1

Answer: B59. How do you add a single-line comment inJavaScript?A) // commentB) <!-- comment -->C) # commentD) /* comment */Answer: A60. Which operator is used to add values inJavaScript?A) +B) &C) addD) plusAnswer: A
Internet and WWW
61. What does WWW stand for?A) World Wide WebB) Wide World WebC) Web World WideD) Web Wide WorldAnswer: A62. Who invented the World Wide Web?A) Bill GatesB) Tim Berners-LeeC) Steve JobsD) Larry PageAnswer: B63. Which protocol is used to access webpages?A) FTPB) HTTPC) SMTPD) SNMPAnswer: B64. What is the full form of URL?A) Uniform Resource LocatorB) Uniform Reference LinkC) Universal Resource LinkD) Universal Reference LocatorAnswer: A65. Which device is required to connect to theInternet?A) SwitchB) ModemC) Printer
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D) ScannerAnswer: B66. What is a web browser?A) A program to create web pagesB) A program to view web pagesC) A program to edit web pagesD) A program to design web pagesAnswer: B67. Which of the following is not a webbrowser?A) ChromeB) FirefoxC) WindowsD) SafariAnswer: C
68. Which protocol is used for securecommunication over the web?A) HTTPB) FTPC) HTTPSD) SMTPAnswer: C69. What is the main page of a website called?A) Index pageB) Home pageC) Start pageD) Main pageAnswer: B70. Which of the following is a search engine?A) GoogleB) FacebookC) TwitterD) WhatsAppAnswer: A71. Which of the following is not a searchengine?A) BingB) YahooC) InstagramD) DuckDuckGoAnswer: C72. Which organization manages domainnames on the Internet?A) ICANNB) IETFC) IEEED) ISO

Answer: A73. What is the function of DNS?A) Assign IP addressesB) Resolve domain names to IP addressesC) Encrypt dataD) Connect LANsAnswer: B74. Which of the following is not a top-leveldomain?A) .comB) .orgC) .netD) .htmAnswer: D75. What is the default port for HTTP?A) 21B) 23C) 25D) 80Answer: D76. What is the default port for HTTPS?A) 80B) 443C) 21D) 110Answer: B77. Which protocol is used for sending emails?A) SMTPB) POP3C) HTTPD) FTPAnswer: A78. Which protocol is used for receivingemails?A) SMTPB) POP3C) HTTPD) FTPAnswer: B79. Which protocol is used for transferringfiles?A) FTPB) SMTPC) HTTPD) SNMPAnswer: A80. Which of the following is not a valid URL?A) https://www.example.com
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B) ftp://files.example.comC) www.example.comD) http://www.example.comAnswer: C
Applied & Miscellaneous
81. Which HTML tag is used to play video files?A) <video>B) <media>C) <movie>D) <play>Answer: A82. Which HTML tag is used to play audio files?A) <audio>B) <sound>C) <music>D) <play>Answer: A83. Which CSS property is used to change thesize of text?A) font-sizeB) text-sizeC) sizeD) font-styleAnswer: A84. Which HTML tag is used for creating forms?A) <form>B) <input>C) <button>D) <submit>Answer: A85. Which attribute is used to specify thedestination of a link in HTML?A) hrefB) srcC) linkD) urlAnswer: A86. Which tag is used to add a comment inHTML?A) <!-- comment -->B) // commentC) # commentD) /* comment */Answer: A87. Which CSS property is used to make thetext italic?

A) font-style: italic;B) font-italic: true;C) style: italic;D) text-style: italic;Answer: A88. Which JavaScript function is used to displaya dialog box for input?A) prompt()B) alert()C) input()D) dialog()Answer: A
89. Which HTML tag is used to display anumbered list?A) <ol>B) <ul>C) <li>D) <dl>Answer: A90. Which of the following is not a valid CSSunit?A) pxB) emC) ptD) kgAnswer: D91. Which tag is used to define a footer for adocument or section?A) <footer>B) <bottom>C) <foot>D) <section>Answer: A92. Which HTML tag is used to specify a headerfor a document or section?A) <header>B) <head>C) <top>D) <section>Answer: A93. Which CSS property is used to set thetransparency of an element?A) opacityB) transparencyC) visibleD) alphaAnswer: A
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94. Which JavaScript method is used to writecontent into an HTML document?A) document.write()B) write()C) document.content()D) document.print()Answer: A95. Which HTML tag is used to create aclickable button?A) <button>B) <input type="button">C) Both A and BD) <click>Answer: C96. Which CSS property is used to add a borderto an element?A) borderB) border-styleC) border-widthD) border-colorAnswer: A97. Which of the following is not a validJavaScript data type?A) NumberB) StringC) BooleanD) CharacterAnswer: D98. Which attribute is used to specify inline CSSstyles?A) styleB) cssC) classD) idAnswer: A99. Which tag is used to group inline-elementsin HTML?A) <span>B) <div>C) <section>D) <group>Answer: A100. Which tag is used to group block-levelelements in HTML?A) <div>B) <span>C) <section>D) <group>

Answer: A



108 | P a g e

Topic 8: MS Office Suite: Word, Excel, PowerPoint, and PracticalApplications in Education

MSWord
1. What is the default file extension for Word2016 documents?A) .docB) .docxC) .txtD) .pdfAnswer: B2. Which menu contains the ‘Save As’ option inMS Word?A) FileB) HomeC) InsertD) ReviewAnswer: A3. Which shortcut key is used to copy selectedtext in Word?A) Ctrl+XB) Ctrl+CC) Ctrl+VD) Ctrl+ZAnswer: B4. Which feature checks spelling as you type inWord?

A) AutoCorrectB) Spell CheckC) ThesaurusD) Grammar CheckAnswer: B5. What is the function of ‘Mail Merge’ inWord?A) Formatting textB) Combining letters with a data sourceC) Printing documentsD) Saving filesAnswer: B6. Which tab is used to insert a table in a Worddocument?A) FileB) InsertC) HomeD) ReviewAnswer: B7. Which key combination is used to make textbold?A) Ctrl+IB) Ctrl+UC) Ctrl+BD) Ctrl+PAnswer: C8. What is the default orientation of a Worddocument?A) LandscapeB) PortraitC) VerticalD) HorizontalAnswer: B9. Which feature allows you to see how yourdocument will look when printed?A) Print PreviewB) Page LayoutC) Save AsD) ViewAnswer: A10. Which option is used to add page numbersin Word?A) Insert > Page NumberB) Home > Page NumberC) Layout > Number
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D) Review > InsertAnswer: A11. What is the maximum font size available inthe font size drop-down in Word?A) 72B) 100C) 96D) 48Answer: A12. Which tool is used to find synonyms inWord?A) Spell CheckB) ThesaurusC) GrammarD) DictionaryAnswer: B13. Which shortcut is used to undo the lastaction in Word?A) Ctrl+UB) Ctrl+YC) Ctrl+ZD) Ctrl+XAnswer: C14. Which tab contains the ‘Track Changes’feature?A) HomeB) ReviewC) InsertD) ViewAnswer: B15. What is the function of the ‘Header’ inWord?A) Adds text at the top of each pageB) Adds text at the bottomC) Adds footnotesD) Adds endnotesAnswer: A16. Which shortcut is used to select all contentin a document?A) Ctrl+SB) Ctrl+AC) Ctrl+PD) Ctrl+FAnswer: B17. Which key is used to create a newdocument in Word?A) Ctrl+NB) Ctrl+O

C) Ctrl+MD) Ctrl+KAnswer: A18. Which option is used to check the wordcount?A) Review > Word CountB) Home > Word CountC) Insert > Word CountD) File > InfoAnswer: A19. Which feature automatically moves text tothe next line as you type?A) Word WrapB) Line BreakC) ParagraphD) IndentAnswer: A20. Which option is used to insert a hyperlinkin Word?A) Insert > HyperlinkB) Home > LinkC) Layout > HyperlinkD) Review > LinkAnswer: A
MS Excel
21. What is the default file extension for Excel2016 workbooks?A) .xlsB) .xlsxC) .csvD) .docxAnswer: B22. Which symbol is used to start a formula inExcel?A) =B) +C) -D) *Answer: A23. Which function is used to sum a range ofcells?A) ADDB) SUMC) TOTALD) COUNTAnswer: B
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24. What is a cell reference in Excel?A) The cell’s address (e.g., A1)B) The cell’s valueC) The cell’s formatD) The cell’s formulaAnswer: A25. Which shortcut key is used to save an Excelworkbook?A) Ctrl+PB) Ctrl+SC) Ctrl+ND) Ctrl+OAnswer: B26. Which function returns the average of arange of values?A) AVERAGEB) MEANC) MEDIAND) SUMAnswer: A27. Which feature is used to quickly fill a seriesin Excel?A) AutoFillB) Fill DownC) Fill SeriesD) All of the aboveAnswer: D28. Which function counts the number ofnumeric values in a range?A) COUNTB) COUNTAC) COUNTIFD) SUMAnswer: A29. Which chart type is best for showing trendsover time?A) PieB) LineC) BarD) ColumnAnswer: B30. What is the intersection of a row andcolumn called?A) FieldB) CellC) RangeD) DataAnswer: B

31. Which function finds the highest value in arange?A) MAXB) MINC) HIGHD) TOPAnswer: A32. Which function is used to look up a value ina table?A) LOOKUPB) VLOOKUPC) FINDD) SEARCHAnswer: B33. Which feature allows you to arrange datain ascending or descending order?A) SortB) FilterC) GroupD) Data TableAnswer: A34. Which Excel feature is used to highlightcells based on conditions?A) Conditional FormattingB) Data ValidationC) SortingD) FilteringAnswer: A35. Which key combination is used to insert anew worksheet?A) Shift+F11B) Ctrl+NC) Ctrl+Shift+ND) Alt+NAnswer: A36. Which function returns the current date?A) TODAY()B) NOW()C) DATE()D) CURRENTDATE()Answer: A37. Which function counts all non-empty cellsin a range?A) COUNTB) COUNTAC) COUNTBLANKD) COUNTIFAnswer: B
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38. Which function is used to round numbers?A) ROUNDB) ROUNDOFFC) ROUNDUPD) ROUNDDOWNAnswer: A39. Which feature allows you to limit the typeof data entered in a cell?A) Data ValidationB) Conditional FormattingC) SortingD) FilteringAnswer: A40. Which tab contains the ‘PivotTable’option?A) InsertB) DataC) HomeD) ReviewAnswer: A_____________________________________
MS PowerPoint
41. What is the default file extension forPowerPoint 2016 presentations?A) .pptB) .pptxC) .ppsD) .potAnswer: B42. Which view is used to display slides one byone during a presentation?A) Slide SorterB) Slide ShowC) NormalD) OutlineAnswer: B43. Which shortcut starts a slideshow from thebeginning?A) F5B) F2C) F7D) F9Answer: A44. Which tab is used to insert a new slide?A) HomeB) Insert

C) DesignD) ViewAnswer: A45. Which feature adds movement to text andobjects on a slide?A) AnimationB) TransitionC) Slide ShowD) LayoutAnswer: A46. Which feature adds movement betweenslides?A) AnimationB) TransitionC) Slide ShowD) LayoutAnswer: B47. Which key is used to move to the next slideduring a presentation?A) EnterB) SpacebarC) Right ArrowD) All of the aboveAnswer: D48. Which option is used to insert a chart inPowerPoint?A) Insert > ChartB) Home > ChartC) Design > ChartD) Review > ChartAnswer: A49. Which tab contains the ‘Slide Master’option?A) ViewB) InsertC) DesignD) HomeAnswer: A50. Which option is used to print handouts ofslides?A) File > PrintB) Home > PrintC) Insert > PrintD) Design > PrintAnswer: A51. Which feature is used to add speakernotes?A) Notes Pane
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B) CommentC) FooterD) HeaderAnswer: A52. Which tab contains the ‘SmartArt’ option?A) InsertB) DesignC) HomeD) ViewAnswer: A53. Which shortcut is used to duplicate a slide?A) Ctrl+DB) Ctrl+CC) Ctrl+ND) Ctrl+MAnswer: A54. Which file format is used for a PowerPointtemplate?A) .potxB) .pptxC) .ppsxD) .docxAnswer: A55. Which feature checks spelling inPowerPoint?A) SpellingB) GrammarC) ProofingD) ReviewAnswer: A56. Which option is used to insert a video inPowerPoint?A) Insert > VideoB) Home > VideoC) Design > VideoD) View > VideoAnswer: A57.Which tab contains the ‘Header & Footer’option?A) InsertB) DesignC) HomeD) ViewAnswer: A58.Which view displays all slides asthumbnails?A) Slide SorterB) Slide Show

C) OutlineD) NormalAnswer: A59.Which feature is used to rehearse timingsfor slides?A) Slide Show > Rehearse TimingsB) Insert > TimingsC) Design > TimingsD) View > TimingsAnswer: A60.Which option is used to insert audio inPowerPoint?A) Insert > AudioB) Home > AudioC) Design > AudioD) View > AudioAnswer: A
Practical Applications in Education
61. Which MS Office application is best forcreating student report cards?A) WordB) ExcelC) PowerPointD) AccessAnswer: B62. Which application is ideal for preparingclassroom presentations?A) WordB) ExcelC) PowerPointD) AccessAnswer: C63. Which feature in Word helps teacherscheck for plagiarism?A) Track ChangesB) ThesaurusC) Smart LookupD) CompareAnswer: C64. Which Excel feature is useful for analyzingstudent performance?A) PivotTableB) Mail MergeC) Slide ShowD) SmartArtAnswer: A
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65. Which PowerPoint feature can be used tocreate interactive quizzes?A) AnimationB) HyperlinkC) Slide MasterD) ChartAnswer: B66. Which application is best for maintainingstudent attendance records?A) WordB) ExcelC) PowerPointD) AccessAnswer: B67. Which feature in Word allows collaborativeediting?A) Track ChangesB) CommentsC) ShareD) All of the aboveAnswer: D68. Which Excel function helps in calculatingaverage marks?A) SUMB) AVERAGEC) MAXD) MINAnswer: B69. Which PowerPoint feature is useful foradding visual interest to lessons?A) TransitionsB) AnimationsC) Both A and BD) NoneAnswer: C70. Which application is best for creatingcertificates for students?A) WordB) ExcelC) PowerPointD) AccessAnswer: A71. Which feature in Excel helps in restrictingdata entry to specific values?A) Data ValidationB) Conditional FormattingC) SortingD) Filtering

Answer: A72. Which PowerPoint feature allows you torecord narration?A) Record Slide ShowB) AnimationC) TransitionD) Slide SorterAnswer: A73. Which application helps in preparingquestion papers?A) WordB) ExcelC) PowerPointD) AccessAnswer: A74. Which feature in Word helps in creatingbibliographies?A) ReferencesB) ReviewC) MailingsD) ViewAnswer: A75. Which Excel feature is useful for markingstudent absences automatically?A) Conditional FormattingB) Data ValidationC) PivotTableD) SortingAnswer: A76. Which PowerPoint view is best forrearranging slides?A) Slide SorterB) NormalC) OutlineD) Slide ShowAnswer: A77. Which application is best for preparingnewsletters?A) WordB) ExcelC) PowerPointD) AccessAnswer: A78. Which feature in Excel can be used forbudgeting school expenses?A) FormulasB) ChartsC) Both A and B
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D) NoneAnswer: C79. Which PowerPoint feature allows for grouppresentations?A) CollaborationB) Presenter ViewC) Slide ShowD) Slide MasterAnswer: A80. Which feature in Word helps in creating atable of contents?A) ReferencesB) InsertC) LayoutD) ReviewAnswer: A_____________________________________
Miscellaneous & PYQs
81. Which shortcut is used to print a documentin any MS Office application?A) Ctrl+PB) Ctrl+OC) Ctrl+SD) Ctrl+NAnswer: A82. Which feature in Word helps in correctingspelling errors?A) Spell CheckB) Grammar CheckC) ThesaurusD) Word CountAnswer: A83. Which Excel function is used to count blankcells?A) COUNTB) COUNTAC) COUNTBLANKD) COUNTIFAnswer: C84. Which shortcut is used to open a newpresentation in PowerPoint?A) Ctrl+NB) Ctrl+OC) Ctrl+PD) Ctrl+MAnswer: A

85. Which feature in Word helps in creatinglabels for envelopes?A) Mail MergeB) TableC) HeaderD) FooterAnswer: A86. Which Excel chart is best for showing partsof a whole?A) Pie ChartB) Line ChartC) Bar ChartD) Column ChartAnswer: A87. Which PowerPoint feature is used to insertpre-designed slide layouts?A) Slide MasterB) ThemesC) DesignD) LayoutAnswer: D88. Which shortcut is used to save a documentin any MS Office application?A) Ctrl+SB) Ctrl+NC) Ctrl+PD) Ctrl+OAnswer: A89. Which feature in Word is used for creatingfootnotes?A) ReferencesB) ReviewC) InsertD) LayoutAnswer: A90. Which Excel function checks a conditionand returns one value if true, and another iffalse?A) IFB) COUNTIFC) SUMIFD) VLOOKUPAnswer: A91. Which PowerPoint feature is used to add abackground image to slides?A) Design > Format BackgroundB) Insert > PictureC) Home > Background
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D) View > BackgroundAnswer: A92. Which application is best for statisticalanalysis of student data?A) ExcelB) WordC) PowerPointD) AccessAnswer: A93. Which feature in Word is used for insertingcitations?A) ReferencesB) ReviewC) LayoutD) InsertAnswer: A94. Which Excel feature is used to combinedata from multiple sheets?A) ConsolidateB) MergeC) SortD) FilterAnswer: A95. Which PowerPoint feature is used to inserta screenshot?A) Insert > ScreenshotB) Home > ScreenshotC) Design > ScreenshotD) View > ScreenshotAnswer: A96. Which shortcut is used to close an opendocument in MS Office?A) Ctrl+WB) Ctrl+QC) Ctrl+ED) Ctrl+RAnswer: A97. Which Excel function is used to find thelowest value in a range?A) MINB) MAXC) LOWD) SMALLAnswer: A98. Which feature in Word helps in translatingtext?A) TranslateB) Thesaurus

C) DictionaryD) Spell CheckAnswer: A99. Which PowerPoint feature is used to insertshapes?A) Insert > ShapesB) Home > ShapesC) Design > ShapesD) View > ShapesAnswer: A100. Which application is best for preparing aschool timetable?A) ExcelB) WordC) PowerPointD) AccessAnswer: A
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Topic 9: Computer Security: Viruses, Malware, Firewalls, SafePractices"

Viruses and Malware
1. What is a computer virus?A) Hardware deviceB) Malicious softwareC) Operating systemD) Application softwareAnswer: B2. Which of the following is NOT a type ofmalware?A) WormB) Trojan horseC) FirewallD) RansomwareAnswer: C3. A program that replicates itself and spreadsto other computers is called:A) VirusB) WormC) FirewallD) AntivirusAnswer: B4. Which malware disguises itself as legitimatesoftware?

A) Trojan horseB) WormC) SpywareD) AdwareAnswer: A5. Which malware is designed to collect userinformation secretly?A) SpywareB) AdwareC) RansomwareD) RootkitAnswer: A6. Which malware locks your files anddemands payment?A) AdwareB) RansomwareC) TrojanD) WormAnswer: B7. What is the main purpose of adware?A) Steal dataB) Display unwanted adsC) Encrypt filesD) Delete filesAnswer: B8. Which malware records keystrokes to stealpasswords?A) KeyloggerB) RootkitC) WormD) AdwareAnswer: A9. Which malware can hide itself and othermalware from detection?A) RootkitB) WormC) SpywareD) AdwareAnswer: A10. Which of the following is NOT a wayviruses spread?A) USB drivesB) Email attachments
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C) Downloading filesD) Using a firewallAnswer: D_____________________________________
Antivirus and Protection
11. What is the main function of antivirussoftware?A) Create virusesB) Detect and remove malwareC) Speed up the computerD) Backup dataAnswer: B12. Which of the following is NOT an antivirussoftware?A) AvastB) NortonC) Windows DefenderD) ExcelAnswer: D13. Regularly updating antivirus software isimportant because:A) It increases computer speedB) It keeps the software effective against newthreatsC) It adds new gamesD) It changes the user interfaceAnswer: B14. What should you do if your antivirusdetects a threat?A) Ignore itB) Delete or quarantine the fileC) Uninstall antivirusD) Turn off the computerAnswer: B15. Which of the following is a sign of virusinfection?A) Slow performanceB) Unexpected pop-upsC) Files missing or corruptedD) All of the aboveAnswer: D16. What is quarantine in antivirus software?A) Deleting filesB) Isolating suspicious filesC) Updating softwareD) Scanning hardware

Answer: B17. Which of the following is a good practice toavoid malware?A) Download software from official sitesB) Click on all email linksC) Use pirated softwareD) Disable antivirusAnswer: A18. Which type of scan checks the wholesystem for threats?A) Full scanB) Quick scanC) Custom scanD) Partial scanAnswer: A19. Which of the following is NOT a preventivemeasure against viruses?A) Regular backupsB) Using strong passwordsC) Disabling firewallD) Updating softwareAnswer: C20. What is the first action after detectingransomware?A) Pay the ransomB) Disconnect from the networkC) Delete all filesD) Ignore the warningAnswer: B
Firewalls
21. What is a firewall?A) Antivirus softwareB) Security device/software that filters networktrafficC) Operating systemD) DatabaseAnswer: B22. Which of the following is NOT a type offirewall?A) Hardware firewallB) Software firewallC) Human firewallD) Cloud firewallAnswer: C23. What is the main function of a firewall?A) Block unauthorized access
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B) Create virusesC) Format hard diskD) Increase RAMAnswer: A24. Which firewall is installed on individualcomputers?A) Hardware firewallB) Software firewallC) Network firewallD) NoneAnswer: B25. Where is a hardware firewall usuallyplaced?A) Between the computer and the printerB) Between the network and the internetC) Inside the CPUD) In the RAMAnswer: B26. Which of the following is a popularsoftware firewall for Windows?A) Windows FirewallB) ExcelC) BIOSD) ChromeAnswer: A27. Firewalls can be used to:A) Block specific websitesB) Allow only trusted applicationsC) Prevent hackersD) All of the aboveAnswer: D28. What does a firewall NOT do?A) Prevent unauthorized accessB) Scan for virusesC) Filter network trafficD) Block suspicious connectionsAnswer: B29. What is the default firewall in WindowsOS?A) Windows DefenderB) Windows FirewallC) McAfeeD) AVGAnswer: B30. Which layer of the OSI model do firewallsprimarily operate at?A) PhysicalB) Network

C) ApplicationD) All of the aboveAnswer: D
Safe Practices
31. What is the best way to create a strongpassword?A) Use your nameB) Use "123456"C) Use a mix of letters, numbers, and symbolsD) Use only lowercase lettersAnswer: C32. Which of the following is NOT a safeinternet practice?A) Clicking on suspicious linksB) Using HTTPS websitesC) Logging out after useD) Updating software regularlyAnswer: A33. What should you do before opening anemail attachment?A) Check the senderB) Scan with antivirusC) Be cautious with unknown sourcesD) All of the aboveAnswer: D34. Why should you avoid using piratedsoftware?A) It is illegalB) It may contain malwareC) No official supportD) All of the aboveAnswer: D35. What is phishing?A) Fishing in a riverB) Attempt to steal personal informationthrough fake emails/websitesC) Encrypting filesD) Installing antivirusAnswer: B36. What is the safest way to use public Wi-Fi?A) Use a VPNB) Share personal infoC) Disable firewallD) Turn off antivirusAnswer: A
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37. Which of the following should you NOTshare online?A) PasswordsB) Bank detailsC) Personal identificationD) All of the aboveAnswer: D38. What is two-factor authentication?A) Using two passwordsB) Using password and another verificationmethodC) Using two devicesD) Using two browsersAnswer: B39. What should you do if you suspect yourcomputer is infected?A) Run antivirus scanB) Disconnect from the internetC) Seek expert helpD) All of the aboveAnswer: D40. Which of these is a good backup practice?A) Backup regularlyB) Use external or cloud storageC) Test backupsD) All of the aboveAnswer: D
Network Security and Threats
41. What is a hacker?A) Someone who repairs computersB) Someone who illegally accesses systemsC) Antivirus softwareD) A type of malwareAnswer: B42. What is ethical hacking?A) Hacking for funB) Authorized hacking to find vulnerabilitiesC) Creating virusesD) Illegal activityAnswer: B43. What is the purpose of a security patch?A) To fix vulnerabilitiesB) To slow down the systemC) To delete filesD) To install gamesAnswer: A

44. What is social engineering?A) Building bridgesB) Manipulating people to reveal confidentialinfoC) ProgrammingD) Installing antivirusAnswer: B45. What is spam?A) Unwanted emailsB) AntivirusC) BackupD) FirewallAnswer: A46. Which of the following is NOT a cyberthreat?A) VirusB) WormC) FirewallD) TrojanAnswer: C47. What is the main goal of cyber security?A) To create malwareB) To protect data and systemsC) To slow down computersD) To delete filesAnswer: B48. Which of the following is NOT a physicalsecurity measure?A) Locking computersB) Using antivirusC) Restricting access to server roomsD) Security camerasAnswer: B49. What is a botnet?A) Network of infected computersB) Antivirus softwareC) FirewallD) Backup systemAnswer: A50. What is the first step in responding to adata breach?A) Ignore itB) Identify and contain the breachC) Delete all dataD) Pay ransomAnswer: B
Backup and Recovery
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51. What is the purpose of data backup?A) To delete filesB) To recover data after lossC) To slow down the computerD) To install softwareAnswer: B52. Which of the following is NOT a backupdevice?A) External hard driveB) USB flash driveC) PrinterD) Cloud storageAnswer: C53. How often should important data bebacked up?A) Once a yearB) RegularlyC) NeverD) Only after a virus attackAnswer: B54. What is cloud backup?A) Storing data on remote serversB) Printing documentsC) Installing antivirusD) Formatting hard disksAnswer: A55. What is the first step after data loss?A) PanicB) Try to recover from backupC) Delete more filesD) Ignore the problemAnswer: B56. Which of the following is NOT a type ofbackup?A) Full backupB) Incremental backupC) Differential backupD) Virtual backupAnswer: D57. What is restore?A) Deleting filesB) Recovering data from backupC) Formatting drivesD) Installing softwareAnswer: B58. Which backup method saves only changedfiles since the last backup?

A) Full backupB) Incremental backupC) Differential backupD) Manual backupAnswer: B59. What is the main advantage of cloudbackup?A) Accessible from anywhereB) Slower accessC) Less secureD) More expensiveAnswer: A60. What should be done after restoring datafrom a backup?A) Check data integrityB) Ignore errorsC) Delete backupD) Turn off computerAnswer: A
Email and Internet Safety
61. What is phishing?A) Sending fake emails to steal informationB) Installing antivirusC) Encrypting filesD) Formatting hard diskAnswer: A62. Which of the following is a sign of aphishing email?A) Urgent request for personal infoB) Suspicious linksC) Spelling errorsD) All of the aboveAnswer: D63. What is the best way to avoid phishing?A) Ignore all emailsB) Verify sender and linksC) Click on every linkD) Share passwordsAnswer: B64. What is spam?A) Unwanted emailsB) AntivirusC) BackupD) FirewallAnswer: A65. What is the purpose of email filters?
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A) Block spam and phishing emailsB) Send emailsC) Format emailsD) Encrypt emailsAnswer: A66. What should you do if you receive asuspicious email?A) Click all linksB) Delete or report itC) Reply with personal infoD) Forward to everyoneAnswer: B67. Which of the following is NOTrecommended for safe browsing?A) Use strong passwordsB) Use public Wi-Fi for bankingC) Enable two-factor authenticationD) Use secure websitesAnswer: B68. What is HTTPS?A) Secure version of HTTPB) Email protocolC) VirusD) Backup methodAnswer: A69. What does a padlock symbol in thebrowser mean?A) The site is secureB) The site is unsafeC) The site is slowD) The site is under maintenanceAnswer: A70. What is the safest way to download files?A) From trusted sourcesB) From random pop-upsC) From unknown emailsD) From pirated websitesAnswer: A
Mobile and Device Security
71. What is the best way to secure asmartphone?A) Use a password or PINB) Share it with everyoneC) Disable security featuresD) Never update appsAnswer: A

72. Which of the following can protect againstmobile malware?A) Download apps from official storesB) Install apps from unknown sourcesC) Ignore updatesD) Disable antivirusAnswer: A73. What is the purpose of app permissions?A) Control app access to data and featuresB) Increase phone speedC) Delete appsD) Install virusesAnswer: A74. Which of the following is NOT a mobilesecurity risk?A) Outdated appsB) Weak passwordsC) Using official app storesD) Public Wi-FiAnswer: C75. What should you do before selling your oldphone?A) Delete all data and resetB) Give it away as isC) Share passwordsD) Leave accounts logged inAnswer: A76. Which of the following is NOT a safepractice for mobile devices?A) Lock your phoneB) Install updatesC) Use public Wi-Fi for sensitive tasksD) Backup dataAnswer: C77. What is SIM card lock?A) Locks the SIM with a PINB) Deletes all contactsC) Installs antivirusD) Formats the phoneAnswer: A78. What is the main risk of public chargingstations?A) Juice jacking (data theft)B) Faster chargingC) Free internetD) More storageAnswer: A79. What is Bluetooth security risk?
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A) Unauthorized access via BluetoothB) Faster internetC) Better sound qualityD) More battery lifeAnswer: A80. What is the best way to secure wirelessnetworks?A) Use strong Wi-Fi passwordsB) Leave Wi-Fi openC) Share passwordsD) Disable encryptionAnswer: A
Educational and Practical Scenarios
81. Why is computer security important inschools?A) To protect student and staff dataB) To prevent cyberbullyingC) To ensure safe learningD) All of the aboveAnswer: D82. Which of the following is a safe practice forteachers using school computers?A) Lock computer when not in useB) Share passwords with studentsC) Install unauthorized softwareD) Disable antivirusAnswer: A83. What should teachers do before using USBdrives in school computers?A) Scan for virusesB) Format the driveC) Share with everyoneD) Ignore securityAnswer: A84. What is the role of firewalls in schoolnetworks?A) Block harmful websitesB) Prevent hackingC) Filter network trafficD) All of the aboveAnswer: D85. Which is NOT a safe email practice forteachers?A) Open attachments from unknown sendersB) Use strong passwordsC) Log out after use

D) Report suspicious emailsAnswer: A86. What is the best way to handle sensitivestudent data?A) Store securely and backupB) Share on social mediaC) Email to everyoneD) Leave on public computersAnswer: A87. What should be done if a school computeris infected?A) Inform IT staffB) Run antivirusC) Disconnect from networkD) All of the aboveAnswer: D88. What is the use of password-protected files?A) Restrict unauthorized accessB) Make files largerC) Slow down computersD) Delete filesAnswer: A89. Why should teachers use official software?A) More secureB) LegalC) Regular updatesD) All of the aboveAnswer: D90. What is the best way to educate studentsabout cyber safety?A) Conduct awareness sessionsB) Ignore the topicC) Share passwordsD) Encourage risky behaviorAnswer: A
Miscellaneous and PYQs
91. What is the main reason for regularsoftware updates?A) Add new featuresB) Fix security vulnerabilitiesC) Change the color schemeD) Increase file sizeAnswer: B92. Which of the following is NOT a type ofmalware?A) Virus
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B) WormC) FirewallD) SpywareAnswer: C93. Which is the best way to protect personaldata online?A) Use strong passwordsB) Share on social mediaC) Ignore securityD) Use public Wi-FiAnswer: A94. What is cyberbullying?A) Online harassmentB) Antivirus softwareC) Data backupD) FirewallAnswer: A95. What is the use of encryption?A) Protect data by making it unreadableB) Delete dataC) Speed up computersD) Install malwareAnswer: A96. What is the first step in case of onlinefraud?A) Report to authoritiesB) IgnoreC) Pay the fraudsterD) Delete evidenceAnswer: A97. Which of the following is NOT a function ofantivirus?A) Detect malwareB) Remove virusesC) Backup dataD) Quarantine threatsAnswer: C98. What is the use of a password manager?A) Store and manage passwords securelyB) Share passwordsC) Create virusesD) Slow down the computerAnswer: A99. What is the best way to preventunauthorized access to computers?A) Use strong passwords and lock screensB) Share passwordsC) Disable security

D) Use public computersAnswer: A100. Which of the following is NOT a benefit ofcomputer security?A) Protects dataB) Prevents unauthorized accessC) Encourages malwareD) Ensures privacyAnswer: C
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Topic 10: ICT in Education: Role of computers in teaching, e-learningtools, digital classroom management

Role of Computers in Teaching
1. What does ICT stand for in education?A) Information and Communication TechnologyB) Indian Computer TechnologyC) International Communication ToolD) Integrated Computer TeachingAnswer: A2. Which of the following is NOT a benefit ofusing computers in teaching?A) Interactive learningB) Limited access to informationC) Multimedia presentationsD) Efficient assessmentAnswer: B3. Computers help in personalized learning by:A) Providing the same content to allB) Adapting content to student’s paceC) Limiting resourcesD) NoneAnswer: B

4. Which software is commonly used forcreating lesson plans?A) MS WordB) MS ExcelC) PhotoshopD) VLC PlayerAnswer: A5. Which of the following is a practical use ofcomputers in schools?A) Maintaining student recordsB) Drawing onlyC) Playing games onlyD) NoneAnswer: A6. Which device is essential for digitalclassrooms?A) ProjectorB) TypewriterC) Overhead projectorD) ChalkboardAnswer: A7. What is the main advantage of usingmultimedia in teaching?A) Makes lessons boringB) Enhances understandingC) Reduces interactionD) NoneAnswer: B8. Computers help teachers to:A) Prepare e-contentB) Analyze student performanceC) Communicate with parentsD) All of the aboveAnswer: D9. What is blended learning?A) Only online teachingB) Only classroom teachingC) Combination of online and classroomteachingD) Teaching with books onlyAnswer: C
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10. Which of the following is NOT a use ofcomputers in education?A) E-booksB) Online quizzesC) Manual attendanceD) Virtual labsAnswer: C
E-Learning Tools
11. What is an LMS?A) Learning Management SystemB) Local Management ServiceC) Language Management SystemD) Learning Machine SystemAnswer: A12. Which of the following is a popular LMS?A) Google ClassroomB) MS PaintC) NotepadD) CalculatorAnswer: A13. Which tool is used for real-time studentassessment?A) Kahoot!B) PaintC) WordPadD) MS DOSAnswer: A14. Which tool allows collaborative documentediting?A) Google DocsB) MS PaintC) VLC PlayerD) CalculatorAnswer: A15. What is the main function of Quizizz?A) Online quizzesB) DrawingC) Video editingD) Audio recordingAnswer: A16. Which tool is used for digitalwhiteboarding?A) ClassroomscreenB) NotepadC) ExcelD) Word

Answer: A17. Which of the following is NOT an e-learningtool?A) SocrativeB) PadletC) BlackboardD) TypewriterAnswer: D18. What is the use of Edulastic?A) Online assessmentB) Video callsC) Image editingD) File compressionAnswer: A19. Which platform is best for sharingassignments and feedback?A) Google ClassroomB) Windows Media PlayerC) MS PaintD) CalculatorAnswer: A20. Which tool helps in behavior managementin digital classrooms?A) ClassDojoB) ExcelC) WordD) PaintAnswer: A
Digital ClassroomManagement
21. What is digital classroom management?A) Using technology to organize and monitorclassroomsB) Manual attendanceC) Only teaching with chalkD) NoneAnswer: A22. Which tool is used for monitoring studentdevice usage?A) Mobile Device Management (MDM)B) PaintC) WordD) ExcelAnswer: A23. What is the benefit of using an LMS forclassroom management?A) Centralizes assignments and grades
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B) Makes teaching difficultC) Reduces transparencyD) Increases paperworkAnswer: A24. Which tool is used for real-timecommunication in digital classrooms?A) Microsoft TeamsB) NotepadC) PaintD) CalculatorAnswer: A25. What is the advantage of using digitalattendance systems?A) Fast and accurateB) Time-consumingC) Error-proneD) NoneAnswer: A26. Which of the following is NOT a digitalclassroom management tool?A) ClassDojoB) Google ClassroomC) BlackboardD) Manual registerAnswer: D27. What is the use of behavior tracking tools?A) Encourage positive behaviorB) Discourage learningC) Increase absenteeismD) NoneAnswer: A28. What is the main aim of digital classroommanagement?A) Efficient learning environmentB) Increase confusionC) Reduce participationD) NoneAnswer: A29. Which tool is used for sharing resourcesand announcements?A) LMSB) PaintC) CalculatorD) NotepadAnswer: A30. What is the benefit of using onlinegradebooks?A) Real-time access to grades

B) Only teachers can seeC) Only students can seeD) NoneAnswer: A
ICT Concepts and General Applications
31. Which of the following is NOT an ICT tool?A) ComputerB) SmartphoneC) ChalkboardD) TabletAnswer: C32. What is the use of assistive technology ineducation?A) Helps students with special needsB) Only for teachersC) For entertainmentD) NoneAnswer: A33. Which tool helps convert handwriting todigital text?A) Livescribe smartpenB) PaintC) WordPadD) CalculatorAnswer: A34. What is the benefit of using digital quizzes?A) Instant feedbackB) Delayed resultsC) No feedbackD) NoneAnswer: A35. Which ICT tool is used for videoconferencing?A) ZoomB) NotepadC) PaintD) CalculatorAnswer: A36. What is the function of Padlet ineducation?A) Collaborative boardsB) Only for drawingC) Only for videoD) NoneAnswer: A
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37. Which of the following is a benefit of e-learning?A) Flexible learningB) Limited accessC) No feedbackD) NoneAnswer: A38. Which technology helps in remotelearning?A) InternetB) Manual registerC) ChalkboardD) NoneAnswer: A39. Which of the following is NOT a benefit ofICT in education?A) Enhances engagementB) Limits access to informationC) Supports inclusive educationD) Enables distance learningAnswer: B40. What is flipped classroom?A) Students learn at home, practice in classB) Only teacher teachesC) Only students teachD) NoneAnswer: A
Previous Year and Expected Questions
41. Which tool is used for creatingpresentations in digital classrooms?A) PowerPointB) PaintC) NotepadD) CalculatorAnswer: A42. Which of the following is a digitalassessment tool?A) QuizizzB) PaintC) WordPadD) CalculatorAnswer: A43. Which platform is used for collaborativespreadsheet work?A) Google SheetsB) Paint

C) VLCD) NotepadAnswer: A44. Which of the following is a benefit of usinge-books?A) Portable and accessibleB) Heavy and bulkyC) Only available in librariesD) NoneAnswer: A45. Which device is used for scanningdocuments?A) ScannerB) PrinterC) MonitorD) KeyboardAnswer: A46. What is the use of digital projectors inclassrooms?A) Display multimedia contentB) Only for soundC) Only for printingD) NoneAnswer: A47. Which of the following supports groupdiscussion in online classes?A) Discussion forumsB) PaintC) CalculatorD) WordPadAnswer: A48. Which tool is used for creating and sharingmind maps?A) MindMeisterB) PaintC) ExcelD) NotepadAnswer: A49. What is the function of Google Forms ineducation?A) Online surveys and quizzesB) DrawingC) Video editingD) NoneAnswer: A50. Which of the following is NOT acollaborative tool?A) Google Docs
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B) PadletC) MS PaintD) Microsoft TeamsAnswer: C
Digital Literacy and Safe Practices
51. What is digital literacy?A) Ability to use digital tools safely andeffectivelyB) Only reading booksC) Only using chalkboardD) NoneAnswer: A52. Which of the following is NOT a safe digitalpractice for students?A) Sharing passwordsB) Using strong passwordsC) Reporting cyberbullyingD) Respecting privacyAnswer: A53. What is cyberbullying?A) Online harassmentB) Printing documentsC) Drawing onlineD) NoneAnswer: A54. Which tool helps in monitoring digitalbehavior?A) ClassDojoB) PaintC) NotepadD) CalculatorAnswer: A55. What is the use of parental controls?A) Restrict inappropriate contentB) Increase screen timeC) Reduce learningD) NoneAnswer: A56. Which of the following is NOT a benefit ofdigital classroom management?A) Efficient monitoringB) Increased paperworkC) Better communicationD) Real-time feedbackAnswer: B

57. What is the use of cloud storage ineducation?A) Access files from anywhereB) Only store locallyC) Increase riskD) NoneAnswer: A58. Which of the following is a secure way toshare resources?A) Using LMSB) Public forumsC) Social mediaD) NoneAnswer: A59. What is the main purpose of digitalcitizenship education?A) Teach responsible online behaviorB) Ignore digital rulesC) Promote unsafe practicesD) NoneAnswer: A60. Which of the following is NOT a digitalcommunication tool?A) EmailB) SMSC) ChalkboardD) Video callAnswer: C
ICT Policy and Trends
61. Which initiative promotes ICT in Indianschools?A) Digital IndiaB) Swachh BharatC) Make in IndiaD) NoneAnswer: A62. What is the role of NIOS in ICT education?A) Provides online courses and resourcesB) Only conducts examsC) Only prints booksD) NoneAnswer: A63. Which of the following is a government e-learning platform?A) SWAYAMB) Paint
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C) NotepadD) CalculatorAnswer: A64. What is the use of Diksha portal?A) Digital resources for teachers and studentsB) Only for gamesC) Only for drawingD) NoneAnswer: A65. Which of the following is NOT a trend indigital education?A) Virtual classroomsB) Manual registersC) AI-based learningD) GamificationAnswer: B66. What is the use of AI in education?A) Personalized learningB) Only for entertainmentC) Reduces learningD) NoneAnswer: A67. Which of the following is an example ofgamification in education?A) Using points and badgesB) Only lecturesC) Only examsD) NoneAnswer: A68. What is the use of virtual labs?A) Simulate experiments onlineB) Only for writingC) Only for drawingD) NoneAnswer: A69. Which of the following is a benefit ofMOOCs?A) Access to quality courses for allB) Only for teachersC) Only for local studentsD) NoneAnswer: A70. What is the main challenge of ICT in ruraleducation?A) Lack of infrastructureB) Too many computersC) Overuse of internetD) None

Answer: A
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Topic 11: Recent Trends: Cloud Computing, Artificial IntelligenceBasics, IoT, Digital India Initiatives

Cloud Computing1. What is cloud computing?A) Using remote servers to store/process dataB) Using floppy disksC) Sharing files via BluetoothD) Using only local computersAnswer: A2. Which of the following is NOT a cloudservice model?A) IaaSB) PaaSC) SaaSD) BIOSAnswer: D3. Which company is NOT a major cloudcomputing provider?A) AmazonB) GoogleC) MicrosoftD) Nokia

Answer: D4. What does SaaS stand for?A) Software as a ServiceB) Storage as a ServiceC) System as a ServiceD) Server as a ServiceAnswer: A5. Which cloud model combines public andprivate clouds?A) Hybrid cloudB) Private cloudC) Public cloudD) Distributed cloudAnswer: A6. What is the main advantage of cloudcomputing in education?A) Expensive hardwareB) Scalability and remote accessC) Only offline accessD) Manual gradingAnswer: B7. Which of the following is an example ofSaaS?A) Google DocsB) Windows OSC) BIOSD) Hard diskAnswer: A8. What is IaaS?A) Infrastructure as a ServiceB) Internet as a ServiceC) Input as a ServiceD) Instruction as a ServiceAnswer: A9. Which service provides a platform fordevelopers to build applications?A) SaaSB) PaaSC) IaaS
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D) NaaSAnswer: B10. Which of the following is NOT a benefit ofcloud computing?A) On-demand resource availabilityB) High initial hardware costC) Pay-as-you-go pricingD) Easy collaborationAnswer: B______________________________________
Artificial Intelligence (AI) Basics
11. What is Artificial Intelligence?A) Machines performing tasks that requirehuman intelligenceB) Only storing dataC) Only hardware designD) Only networkingAnswer: A12. Which of the following is NOT a domain ofAI?A) Natural Language ProcessingB) Computer VisionC) Data EntryD) RoboticsAnswer: C13. Which is an example of AI in daily life?A) Voice assistantsB) Manual typewriterC) Landline phoneD) Mechanical clockAnswer: A14. What is Machine Learning?A) Machines learning from dataB) Machines only storing dataC) Manual data entryD) Only hardware upgradesAnswer: A15. Which is NOT a type of AI?A) Narrow AIB) General AIC) Superintelligent AID) Mechanical AIAnswer: D16. Which of the following is a subset of AI?A) Machine LearningB) Networking

C) DatabaseD) Assembly LanguageAnswer: A17. What is the main purpose of NaturalLanguage Processing?A) Understand human languageB) Store imagesC) Encrypt dataD) Manage networksAnswer: A18. Which of the following is an AI applicationin education?A) Automated gradingB) Manual attendanceC) Chalkboard writingD) Only oral examsAnswer: A19. Which is a popular programming languagefor AI?A) PythonB) COBOLC) AssemblyD) BASICAnswer: A20. What is Deep Learning?A) Using neural networks for complex tasksB) Only storing dataC) Only hardware upgradesD) Manual calculationsAnswer: A______________________________________
IoT (Internet of Things)
21. What does IoT stand for?A) Internet of ThingsB) Input of TechnologyC) Internet of TechnologyD) Input of ThingsAnswer: A22. Which of the following is an IoT device?A) Smart bulbB) TypewriterC) ChalkboardD) Manual clockAnswer: A23. What is the main function of IoT?A) Connecting physical devices to the internet
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B) Only storing dataC) Only printing documentsD) Only voice callsAnswer: A24. Which protocol is commonly used in IoTdevices?A) MQTTB) HTTPC) SMTPD) POP3Answer: A25. Which of the following is NOT anapplication of IoT in education?A) Smart attendanceB) Automated lightingC) Manual registersD) Real-time monitoringAnswer: C26. What is the benefit of IoT in smartclassrooms?A) Real-time data and automationB) Manual gradingC) Only offline lessonsD) No data analysisAnswer: A27. Which of the following is a challenge forIoT?A) Security and privacyB) Manual attendanceC) Chalkboard writingD) No connectivityAnswer: A28. What is an example of IoT in daily life?A) SmartwatchB) Manual diaryC) ChalkboardD) PenAnswer: A29. Which technology supports IoT for fasterconnectivity?A) 5GB) Dial-upC) TypewriterD) Floppy diskAnswer: A30. Which of the following is a layer in IoTarchitecture?A) Perception layer

B) Application layerC) Network layerD) All of the aboveAnswer: D
Digital India Initiatives
31. What is the main aim of Digital India?A) Digital empowerment of citizensB) Only urban developmentC) Only hardware salesD) Only software updatesAnswer: A32. Which initiative provides free onlinecourses to students and teachers?A) SWAYAMB) IRCTCC) UIDAID) NPCIAnswer: A33. What is BharatNet?A) Rural broadband connectivity projectB) Banking serviceC) Mobile appD) E-commerce portalAnswer: A34. Which portal provides digital resources forschool education?A) DIKSHAB) IRCTCC) DigiLockerD) UPIAnswer: A35. Which initiative promotes coding and STEMin schools?A) Atal Tinkering LabsB) Swachh BharatC) Make in IndiaD) PMJDYAnswer: A36. What is the use of DigiLocker?A) Digital document storageB) Online shoppingC) Food deliveryD) Travel bookingAnswer: A37. The Digital India program was launched inwhich year?
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A) 2015B) 2010C) 2020D) 2012Answer: A38. What is the focus of PM eVidya?A) Digital education for allB) Health insuranceC) BankingD) Tax collectionAnswer: A39. Which initiative aims to bridge the digitaldivide in rural India?A) BharatNetB) Make in IndiaC) Swachh BharatD) UPIAnswer: A40. What is the role of National Digital Libraryof India (NDLI)?A) Provides free digital educational resourcesB) Banking servicesC) InsuranceD) E-commerceAnswer: A
PYQ & Application-Based Questions
41. Which of the following is NOT anapplication of AI?A) Disease diagnosisB) Text-to-speech conversionC) Wireless transmission of electrical energyD) Creating meaningful storiesAnswer: C42. Which of the following is a public ledgertechnology?A) BlockchainB) CloudC) IoTD) AIAnswer: A43. Which of the following is NOT anapplication of blockchain?A) CryptocurrencyB) Data storageC) Manual attendanceD) Smart contracts

Answer: C44. What is edge computing?A) Processing data closer to the sourceB) Only storing data in central serversC) Manual data entryD) Only offline processingAnswer: A45. Which of the following is a benefit of edgecomputing in IoT?A) Reduces latencyB) Increases manual workC) Slows down devicesD) Only works offlineAnswer: A46. What is the main advantage of AI-drivengovernance?A) Faster and more accurate decision-makingB) Manual paperworkC) Only hardware upgradesD) No data analysisAnswer: A47. Which of the following is a challenge forIndia to become a global data centre hub?A) Infrastructure gapsB) High digital growthC) Large internet user baseD) Data localizationAnswer: A48. Which of the following is a Digital Indiainitiative for skilling?A) National Centres of Excellence for SkillingB) Only classroom teachingC) Manual registersD) NoneAnswer: A49. Which technology is promoted formultilingual digital textbooks?A) Bharatiya Bhasha Pustak SchemeB) UPIC) BharatNetD) DigiLockerAnswer: A50. What is a key focus of 2025 Digital India ineducation?A) AI-powered adaptive assessmentsB) Only manual gradingC) Only offline examsD) None
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Answer: A
Mixed & Higher-Order Questions
51. Which of the following is NOT a benefit ofcloud computing for schools?A) Easy collaborationB) High upfront hardware costC) Scalable resourcesD) Online accessAnswer: B52. Which of the following is NOT a type ofcloud deployment?A) PublicB) PrivateC) HybridD) ManualAnswer: D53. What is the main benefit of AI in classroommanagement?A) Automated attendance and personalizedlearningB) Manual registersC) Only chalkboard teachingD) NoneAnswer: A54. Which is NOT an IoT application in schoolinfrastructure?A) Smart lightingB) Automated attendanceC) Manual chalkboardD) Security monitoringAnswer: C55. What is the main aim of Digital PublicInfrastructure (DPI)?A) Seamless digital access to servicesB) Only urban developmentC) Only hardware salesD) NoneAnswer: A56. Which of the following is a governmentplatform for online teacher training?A) DIKSHAB) YouTubeC) WhatsAppD) FacebookAnswer: A

57. Which of the following is NOT a feature ofAI?A) Learning from dataB) Manual data entryC) Pattern recognitionD) Decision makingAnswer: B58. Which of the following is a key challengefor IoT?A) Security and privacyB) Easy automationC) Real-time dataD) Smart devicesAnswer: A59. Which of the following is a benefit of 5G forIoT?A) Faster connectivityB) Slower speedC) Manual data entryD) NoneAnswer: A60. Which of the following is a use of AI inhealthcare?A) Disease diagnosisB) Manual registersC) Only chalkboard teachingD) NoneAnswer: A
Digital India & Technology Policy
61. What is the main goal of India’sSemiconductor PLI scheme?A) Boost domestic chip manufacturingB) Increase manual laborC) Reduce internet usageD) NoneAnswer: A62. Which of the following is a key focus forIndia’s tech future?A) Strengthening digital public infrastructureB) Only hardware importC) Manual registersD) NoneAnswer: A63. What is the role of AI supercomputingclusters?A) Support research and startups
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B) Only manual calculationsC) Only hardware salesD) NoneAnswer: A64. Which government initiative providesdigital certificates and marksheets?A) DigiLockerB) UPIC) IRCTCD) PMJDYAnswer: A65. Which of the following is NOT a cloudcomputing service provider?A) AWSB) Google CloudC) AzureD) MS-DOSAnswer: D66. Which technology is used for secure,decentralized data management?A) BlockchainB) Floppy diskC) TypewriterD) Manual registersAnswer: A67. What is the main benefit of open-source AIframeworks for India?A) Tailored for Indian languages and needsB) Only for foreign useC) Only for hardwareD) NoneAnswer: A68. What is the focus of geospatial intelligencetools?A) Secure navigation and defenseB) Only manual mapsC) Only urban areasD) NoneAnswer: A69. Which of the following is NOT a DigitalIndia impact?A) Improved digital accessB) Only offline educationC) Multilingual contentD) AI in governanceAnswer: B70. Which of the following is a challenge forsustainable tech growth in India?

A) Infrastructure gapsB) High digital adoptionC) Data localizationD) NoneAnswer: A
Application & PYQ Style
71. Which of the following is an application ofAI in governance?A) Welfare distribution optimizationB) Manual paperworkC) Chalkboard writingD) NoneAnswer: A72. Which of the following is a benefit ofindigenous semiconductor manufacturing?A) Reduces import dependencyB) Increases manual registersC) Only hardware salesD) NoneAnswer: A73. Which of the following is a use of satellite-based broadband?A) Rural connectivityB) Only urban areasC) Manual registersD) NoneAnswer: A74. Which of the following is a new trend incloud computing?A) Quantum cloud computingB) Manual data entryC) Only local storageD) NoneAnswer: A75. Which of the following is a focus of India’sNational Research Foundation?A) Deep-tech R&DB) Only hardware salesC) Manual registersD) NoneAnswer: A76. Which of the following is a benefit of DPI ineducation?A) Integrated access to records and credentialsB) Only offline classesC) Manual registers
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D) NoneAnswer: A77. Which of the following is a use of AI inclimate monitoring?A) Remote sensing solutionsB) Only manual weather reportsC) Only urban areasD) NoneAnswer: A78. Which of the following is a feature of edgedata centres?A) Reduce latency for real-time applicationsB) Increase manual workC) Only store data centrallyD) NoneAnswer: A79. Which of the following is a benefit ofpublic-private partnerships in tech?

A) Co-develop scalable solutionsB) Only manual registersC) Only government workD) NoneAnswer: A80. Which of the following is a key focus for AIgovernance in India?A) Ethical and secure frameworksB) Only hardware salesC) Manual registersD) NoneAnswer: A
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